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Preface
The Informatica PowerExchange® for SAP Netweaver User Guide provides information about reading data 
from SAP tables, reading data from SAP BW, and writing data to SAP BW. It is written for database 
administrators and developers who create mappings to read data from SAP or write data to SAP. This book 
assumes you have knowledge of SAP NetWeaver, SAP BW, Informatica Developer, and the database engines 
and systems in your environment.

Informatica Resources

Informatica Network
Informatica Network hosts Informatica Global Customer Support, the Informatica Knowledge Base, and other 
product resources. To access Informatica Network, visit https://network.informatica.com.

As a member, you can:

• Access all of your Informatica resources in one place.

• Search the Knowledge Base for product resources, including documentation, FAQs, and best practices.

• View product availability information.

• Review your support cases.

• Find your local Informatica User Group Network and collaborate with your peers.

Informatica Knowledge Base
Use the Informatica Knowledge Base to search Informatica Network for product resources such as 
documentation, how-to articles, best practices, and PAMs.

To access the Knowledge Base, visit https://kb.informatica.com. If you have questions, comments, or ideas 
about the Knowledge Base, contact the Informatica Knowledge Base team at 
KB_Feedback@informatica.com.

Informatica Documentation
To get the latest documentation for your product, browse the Informatica Knowledge Base at 
https://kb.informatica.com/_layouts/ProductDocumentation/Page/ProductDocumentSearch.aspx.

If you have questions, comments, or ideas about this documentation, contact the Informatica Documentation 
team through email at infa_documentation@informatica.com.
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Informatica Product Availability Matrixes
Product Availability Matrixes (PAMs) indicate the versions of operating systems, databases, and other types 
of data sources and targets that a product release supports. If you are an Informatica Network member, you 
can access PAMs at 
https://network.informatica.com/community/informatica-network/product-availability-matrices.

Informatica Velocity
Informatica Velocity is a collection of tips and best practices developed by Informatica Professional 
Services. Developed from the real-world experience of hundreds of data management projects, Informatica 
Velocity represents the collective knowledge of our consultants who have worked with organizations from 
around the world to plan, develop, deploy, and maintain successful data management solutions.

If you are an Informatica Network member, you can access Informatica Velocity resources at 
http://velocity.informatica.com.

If you have questions, comments, or ideas about Informatica Velocity, contact Informatica Professional 
Services at ips@informatica.com.

Informatica Marketplace
The Informatica Marketplace is a forum where you can find solutions that augment, extend, or enhance your 
Informatica implementations. By leveraging any of the hundreds of solutions from Informatica developers 
and partners, you can improve your productivity and speed up time to implementation on your projects. You 
can access Informatica Marketplace at https://marketplace.informatica.com.

Informatica Global Customer Support
You can contact a Global Support Center by telephone or through Online Support on Informatica Network.

To find your local Informatica Global Customer Support telephone number, visit the Informatica website at 
the following link: 
http://www.informatica.com/us/services-and-training/support-services/global-support-centers.

If you are an Informatica Network member, you can use Online Support at http://network.informatica.com.
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Part I: Getting Started with 
PowerExchange for SAP 
NetWeaver

This part contains the following chapters:

• Introduction to PowerExchange for SAP NetWeaver, 12

• PowerExchange for SAP NetWeaver Configuration, 13

• SAP BW Service Configuration, 24

• SAP Connection, 30
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C h a p t e r  1

Introduction to PowerExchange 
for SAP NetWeaver

This chapter includes the following topics:

• PowerExchange for SAP NetWeaver Overview, 12

• Introduction to SAP NetWeaver, 12

PowerExchange for SAP NetWeaver Overview
PowerExchange for SAP NetWeaver provides connectivity between Informatica Developer and SAP 
NetWeaver.

You can use PowerExchange for SAP NetWeaver to perform the following tasks:

Read data from SAP tables

You can read data from SAP views, or transparent, cluster, and pool tables.

Read data from SAP BW

You can use an Open Hub Destination or InfoSpoke to read data from SAP BW.

Write data to SAP BW

You can use a 3.x data source or 7.x data source to write data to SAP BW.

Introduction to SAP NetWeaver
SAP NetWeaver is an application environment that integrates multiple SAP business applications and 
solutions, such as Customer Relationship Management (CRM), Advanced Planner and Optimizer (APO), and 
Bank Analyzer. SAP NetWeaver is the basis for SAP solutions.

Because the Developer tool works with the SAP NetWeaver application platform, you can integrate the 
Developer tool with any SAP industry solution or mySAP application that provides RFC integration methods.
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C h a p t e r  2

PowerExchange for SAP 
NetWeaver Configuration

This chapter includes the following topics:

• PowerExchange for SAP NetWeaver Configuration Overview, 13

• Prerequisites, 14

• SAP Java Connector 3.0, 14

• Transports Installation and Configuration, 15

• Installing the zpmsetparameters.ab4 Program in the SAP BW System, 22

• PowerExchange for SAP NetWeaver Uninstallation, 23

PowerExchange for SAP NetWeaver Configuration 
Overview

PowerExchange for SAP NetWeaver installs with the Informatica services and clients.

Before you use PowerExchange for SAP NetWeaver to read data from or write data to SAP, perform the 
following tasks:

1. Complete the prerequisite tasks.

2. Install the SAP Java Connector (JCo) 3.0 library files.

3. Install and configure the SAP transports.

4. To read data from or write data to SAP BW, configure an SAP BW Service in the Informatica domain.

5. To read data from SAP BW through an Open Hub Destination, install the zpmsetparameters.ab4 program 
in the SAP BW system.
You can download the zpmsetparameters.ab4 program from the following directory:

Informatica installer zip file/saptrans/BW

13



Prerequisites
Before you configure PowerExchange for SAP NetWeaver, perform the following tasks:

1. Install the Informatica services.

2. Install the Informatica clients. When you install the Informatica clients, the Developer tool is installed.

3. Create a Data Integration Service and a Model Repository Service in the Informatica domain.

SAP Java Connector 3.0
The Developer tool requires the SAP Java Connector 3.0 (SAP JCo 3.0) library files to work with SAP 
connections and data objects.

Download the SAP JCo 3.0 files from the SAP Service Marketplace:

http://service.sap.com/connectors

If you have problems downloading the SAP JCo 3.0 files from the SAP web site, contact SAP Customer 
Support.

Download the SAP JCo 3.0 files to the machine that hosts the Developer tool. Extract the SAP JCo 3.0 files 
and copy the files to the following directories:

File Directory

sapjco3.jar <Informatica installation directory>\clients\DeveloperClient\plugins
\com.infa.adapter.sap.jco_<version>\lib

sapjco3.dll <Informatica installation directory>\clients\DeveloperClient\bin

Note: Because the Developer tool is installed on a 64-bit machine, you must use the 64-bit JCo libraries.

If you do not download and install the SAP JCo 3.0 files, the Developer tool displays the following error 
message when you create SAP connections and data objects:

SAPJCo library files might not be installed. Install the SAPJCo library files and try 
again.

To successfully test an SAP connection in Informatica Administrator, download the SAP JCo 3.0 files to the 
machine that hosts the master gateway node. Extract the SAP JCo 3.0 files and copy the files to the following 
directories on the machine that hosts the master gateway node:

Operating System File Directory

AIX 64-bit, Linux64-X86, Linux Itanium 64-bit, 
Linux-X86

sapjco3.jar <Informatica installation 
directory>/services/shared/jars/
thirdparty

AIX 64-bit, Linux64-X86, Linux Itanium 64-bit, 
Linux-X86

libsapjco3.so <Informatica installation 
directory>/services/shared/bin
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Operating System File Directory

Windows EM64T, Windows 32-bit sapjco3.dll <Informatica installation 
directory>/services/shared/bin

Windows EM64T, Windows 32-bit sapjco3.jar <Informatica installation 
directory>/services/shared/jars/
thirdparty

Transports Installation and Configuration
The transport system is a set of ABAP programs installed on the SAP system. The ABAP programs import 
SAP metadata into the repository. The ABAP programs also enable run-time functionalities, such as passing 
mapping parameters and filters.

You use the transport system in the following situations:

Configuring PowerExchange for SAP NetWeaver

You need to transport customized objects that were provided by Informatica to the SAP system. These 
objects include tables, structures, programs, and functions. The Data Integration Service calls custom 
objects when it makes a request to the SAP system.

Step 1. Delete Transport Programs
When you integrate Informatica on the SAP system for the first time, you do not have to delete the transport 
programs. When you integrate Informatica on the SAP system that was configured for a previous version of 
Informatica, you need to delete the old transport programs from the SAP system. Note the current 
configuration in the /INFATRAN/ZPRGSQ SAP ECC custom table before you delete the transport objects.

Modifying /INFATRAN/
To delete a transport object, register the namespace /INFATRAN/ and enter the repair license. Also, change 
the status of /INFATRAN/ in the SAP system to Modifiable.

1. Go to transaction SE03 and double-click Display/Change Namespaces. 

The SAP system displays the list of namespaces.

2. Right-click /INFATRAN/ and click Display. 

3. Make the following changes to the namespace: 

Field Description

Namespace Unique name to identify the transport programs.

Namespace Role Represents a namespace that you import into the SAP system. You cannot develop this 
namespace. However, you can repair the namespace if you have a valid Repair License.
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Field Description

Repair License Unique license key required to modify or repair transport objects. Enter the license key 
10357544012122787918 to delete or modify a namespace.

Short Text Description of the namespace.

4. Click Save. 

5. Go to transaction SE03 and double-click Set System Change Option. 

The System Change Option screen appears.

6. Change the Global Setting to Modifiable and click Save. 

Deleting Transport Objects
PowerExchange for SAP NetWeaver contains the following package:

• /INFATRAN/ZINFA_RUNTIME

Delete all packages. Before you delete a package, you must delete almost all the objects under it.

1. Go to transaction SE10 and verify whether there is any lock on the objects under the package that you 
want to delete. 

An object is locked when another user is modifying or transporting the object. You must check the list of 
modifiable requests for all users in transaction SE10 and verify if there is any request associated with an 
Informatica object.

2. Release all the modifiable requests associated with the Informatica object. 

3. Go to transaction SE10 and create a workbench for deleting all objects. 

4. Go to transaction SE80, select the package that you want to delete and click display. 

When you select a package, it displays all objects under it, such as function groups, programs, 
transactions, and dictionary objects. Dictionary objects include tables and structures.

5. Select a function group to view its function modules. 

6. Right-click each function module and click Delete. 

7. Right-click the function group and click Delete. 

When you delete a function group, you delete includes and other SAP standard dictionary objects.

8. Right-click each program and click Delete. 

9. When prompted, select Includes and click OK. 

You must delete each program and includes.

10. Right-click each table and click Delete. 

If the tables contain data, delete the data before you delete the tables.

11. Click OK if prompted with the message that the table is used in the program. 

12. Right-click each structure and click Delete. 

13. Click OK if prompted with the message that structure is used in the program. 

14. Go to transaction SE10 and select the transport request created for deleting objects. 

15. Expand the request node and verify the list of objects. 

The list of objects in the request node and the list of objects that you delete from the package must 
match.
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16. Go to transaction SE10, right-click the transport request for deleting the objects, and select Release 
Directly. 

Wait until the export of the change request is complete. Complete the export before you delete the 
package.

17. Go to transaction SE80, right-click the package, and click Delete. 

18. When prompted, create a new local transport request to delete the package. 

19. Go to transaction SE10 and delete the package. 

20. Release the transport request that you created for the deleting package. 

Step 2. Install Transport Objects
Informatica provides a group of design-time and run-time transports. Transports are customized objects 
necessary for SAP integration. These objects include tables, programs, structures, and functions that 
Informatica exports to data files. Place these transports on the SAP system. This process creates a package 
for each group of transports.

The transports you install depend on the version of the SAP system. The transports for an Unicode SAP 
system are available at the saptrans/mySAP/UC location in the installation package. These transports are 
created from SAP version ECC5.0 and ECC6.0.

The directory contains separate directories for the data files and cofiles that you need to place on the SAP 
system. The data files contain the transport objects. The cofiles contain the transport conditions. Each set of 
program files represents a function group that has a specific purpose.

Installing Transport Objects
The SAP system administrator can place the transports using Transport Management System (STMS). The 
installation package has separate directories for the data files and cofiles that you need to place on the SAP 
system. The data files contain the transport objects. The cofiles contain the transport conditions. Each set of 
program files represents a function group that has a specific purpose.

Place transports on the SAP system in the following order:

1. Place the ZINFABC run-time transport on the development system. 

2. Place the run-time transports on the development system. 

3. Place the design-time transports on the development system. The design-time transports you place on 
the development system depend on the PowerExchange for SAP features you want to use. 

4. After you place the transports on the development system, deploy the run-time transports to the test and 
production systems. 

5. To place the transports on SAP using the Transport Management System, go to transaction STMS. 

6. Click Overview > Imports. 

7. Open the target system queue. 

8. Click Extras > Other Requests > Add. 

The Add Transport Request to Import Queue dialog box appears.

9. Add a transport request number. 

When you add a transport request number, delete the prefix. For example, when you add 
ZINFABC_RUN_R900101.R46, delete ZINFABC_RUN. Place the ZINFABC run-time transport first.

10. Click Enter. 

11. From Request, select the transport request number you added, and click Import. 
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12. Repeat steps from 5 through 11 for each transport that you want to add. 

Step 3. Run Transport Programs
After you transport the integration objects, run the following programs:

/INFATRAN/YPMPARSQ

Part of package /INFATRAN/ZINFA_RUNTIME. This program generates unique parameter IDs. Run this 
program on the development, test, and production systems.

/INFATRAN/YPMPRGSQ

Part of package /INFATRAN/ZINFA_DESIGNTIME. Run this program on the development system only. 
Run this program to specify an ABAP program name prefix of up to 10 characters, provide a namespace 
that you have registered with SAP, and determine the starting sequence number. When you upgrade from 
a previous version, you run this program to use the same starting sequence number.

The ABAP program name prefix must start with the letter “Y” or “Z.” Use a unique prefix for each SAP 
system that you transport these objects to. For example, use YPC000001 as the prefix and current 
sequence for one SAP system and ZPM000001 for another SAP system.

When you run the /INFATRAN/YMPRGSQ program, you must select the option to use long names because 
both file mode sessions and stream mode sessions use long names. When you use long names, you generate 
a program name that is 30 characters in length, including the customer namespace.

When you run the /INFATRAN/YMPRGSQ program, you can also select the option to override the existing 
information in the /INFATRAN/ZPRGSQ custom table. For example, if you want to add a custom namespace, 
provide the related information and select the Override existing information option.

Run /INFATRAN/YPMPRGSQ again. When you run the program, set the initial sequence number to <last 
number before upgrade> + 1.

Deploying Run-time Packages to the Test and Production Systems
After you install the transports on the SAP development system, deploy the run-time packages to the test and 
production systems. Before deploying the run-time packages, use the SAP transaction SE10 to verify that no 
existing transport requests include the run-time packages.

1. In the SAP development system, go to transaction SE80. 

The Object Navigator window appears.

2. Display the ZINFABC_RUNTIME package. 

3. Right-click the package name and select Write Transport Request. 

The Transport Package dialog box appears.

4. Click All Objects. 

The Enter Transport Request dialog box appears.

5. Click Create Request. 

The Select Request Type dialog box appears.

6. Click Transport of Copies and then click Enter. 

The Create Request dialog box appears.

7. Enter a short description and click Save. 

8. Go to transaction SE10. 
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The Transport Organizer window appears.

9. For Request Type, select Transport of Copies. 

10. For Request Status, select Modifiable. 

11. Click Display. 

The Transport Organizer: Requests window appears.

12. Double-click the transport request you created. 

The Display Request dialog box appears.

13. On the Properties tab, select the target SAP system to which you want to deploy the package and click 
Enter. 

14. Select the transport request you created and click Release Directly. 

SAP deploys the package to the target system.

15. Repeat steps 1 through 14 to deploy the /INFATRAN/ZINFA_RUNTIME package. 

Step 4. Create Users
Create an appropriate user for development, test, and production environments in SAP. The user you create 
enables dialog-free communication between SAP and Informatica.

Depending on the version of the SAP installation, create a System user or a communication user with the 
appropriate authorization profile.

Tip: Ensure that the Informatica user that you create in SAP and the user that completes the task in SAP have 
the same permissions. 

Step 5. Create Profiles
The SAP administrator needs to create a profile in the development, test, and production SAP system so that 
you can use the integration features. This profile name must include authorization for the objects and related 
activities. The profile on the test system should be the same as the profile on the production system.

The following table shows the authorization necessary for integration:

Authorization Object Production/ 
Development

Integration Feature Activity

S_DEVELOP Development Install and uninstall 
programs

All activities.
Also need to set Development 
ObjectID to PROG.

S_TRANSPRT Development Install and uninstall 
programs

CREATE and CHANGE.
Required for workbench requests 
TTYPE = DTRA.

S_TABU_DIS Production Extract data READ.

S_DATASET Production Staging data to a file READ and WRITE.
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Authorization Object Production/ 
Development

Integration Feature Activity

S_BTCH_JOB Production Release background job DELE, LIST, PLAN, SHOW.
Set Job Operation to RELE.

S_RFC Production
Development

Authorize RFC privileges All activities.
Authorize RFC privileges for 
function group RFC objects of the 
following function groups:
- ZPMV
- ZERP
- ZPMH
- ZPMR
- ZPMP
- ZPMD
- ZPMI
- ZPMF
- SYST
- RFC1
- /INFATRAN/*
- SDIFRUNTIME

Step 6. Create a Package
Create a package to integrate PowerExchange for SAP NetWeaver with mySAP applications using ABAP. 
When you create a mapping with an SAP source definition in the development system, you generate and 
install an ABAP program. By default, the ABAP programs that you generate from the mapping are installed in 
the $TMP package. For easy transport into a test or production system, the SAP administrator needs to 
create a package for the ABAP programs. You cannot transport items from the $TMP package.

1. Go to transaction SE80. 

The Object Navigator window appears.

2. From the list, select Package. 

3. Enter a name for the new package and press Enter. 

SAP prompts you to create a new package.

4. Click OK. 

5. Enter the following information and click the Save button. 

Field Description

Package Name of the package.

Short text Description of the package.

Software component Name of the software component.

Appl. component Name of the application component.

SAP prompts you to select a workbench request.

6. Select a workbench request. Or, create a new workbench request. 
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7. Click Save. 

8. Go to transaction SE10. 

You can view a list of workbench requests in transaction SE10.

9. Right-click the new workbench request and select Release. 

Informatica Developer Transports
When you use Informatica Developer to read data from SAP tables, you must install transports. The 
transports that you need to install depend on the type of data object that you use.

Transports for SAP Table Data Object
If you use the SAP Table data object to read data from SAP tables, you do not need to install any design-time 
transport. You need to install only the run-time transports.

Transports for SAP Unicode Versions 5.0 and Later

Informatica ships transports for SAP Unicode versions 5.0 and later in the following folders:

• Unicode cofiles: Informatica installer zip file/saptrans/mySAP/UC/cofiles
• Unicode data files: Informatica installer zip file/saptrans/mySAP/UC/data

Informatica ships the TBL_READ_RUN_V2 transport in the following folder:

Informatica installer zip file/saptrans/mySAP/common

If you want to install transports on SAP Unicode versions 5.0 and later, install the transports on the SAP 
development system in the same order as listed in the table.

Data and Cofile Names Required/ 
Optional

Transport 
Request

Function 
Group

Functionality

- TBL_READ_RUN_CMP_R900448.EC5
- TBL_READ_RUN_CMP_K900448.EC5

Required - EC5K900448 ZERP For SAP ECC and mySAP add-
on components, including 
CRM, and SAP BI:
Enables compressed data 
transfer when you read data 
from SAP.
Note: Install the 
TBL_READ_RUN_CMP 
transport only for SAP ECC 
versions 5.0 or later. If you 
installed the transport for 
PowerCenter, you do not need 
to install it again for 
Informatica Developer.

- TBL_READ_RUN_V2_R900047.DU5
- TBL_READ_RUN_V2_K900047.DU5

Required - DU5K900047 ZPMD
ZPMP

For SAP ECC and mySAP add-
on components, including 
CRM, and SAP BI:
Supports table extraction for 
data integration.
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Transports for SAP non-Unicode Versions 5.0 and Later

Informatica ships transports for SAP non-Unicode versions 5.0 and later in the following folders:

• Non-Unicode cofiles: Informatica installer zip file/saptrans/mySAP/NUC/cofiles
• Non-Unicode data files: Informatica installer zip file/saptrans/mySAP/NUC/data

Informatica ships the TBL_READ_RUN_V2 transport in the following folder:

Informatica installer zip file/saptrans/mySAP/common

If you want to install transports on SAP non-Unicode versions 5.0 and later, install the transports on the SAP 
development system in the same order as listed in the table.

Data and Cofile Names Required/ 
Optional

Transport 
Request

Function 
Group

Functionality

- TBL_READ_RUN_CMP_R904055.NE5
- TBL_READ_RUN_CMP_K904055.NE5

Required - NE5K904055 ZERP For SAP ECC and mySAP add-
on components, including 
CRM, and SAP BI:
Enables compressed data 
transfer when you read data 
from SAP.
Note: Install the 
TBL_READ_RUN_CMP 
transport only for SAP ECC 
versions 5.0 or later. If you 
installed the transport for 
PowerCenter, you do not need 
to install it again for 
Informatica Developer.

- TBL_READ_RUN_V2_R900047.DU5
- TBL_READ_RUN_V2_K900047.DU5

Required - DU5K900047 ZPMD
ZPMP

For SAP ECC and mySAP add-
on components, including 
CRM, and SAP BI:
Supports table extraction for 
data integration.

Installing the zpmsetparameters.ab4 Program in the 
SAP BW System

To read data from SAP BW through an Open Hub Destination, install the zpmsetparameters.ab4 program in 
the SAP BW system.

1. Download the zpmsetparameters.ab4 program from the following directory: 

Informatica installer zip file/saptrans/BW
2. Install the zpmsetparameters.ab4 program in the SAP BW system. 
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Enter the following input parameters to install the zpmsetparameters.ab4 program:

Input Parameter Description

DEST Name of the RFC destination of type third-party tool that you specified while creating the 
open hub destination.

OHDEST Open hub destination name or the value you specified for the Destination field when you 
created the InfoSpoke.

PROJECT Name of the project that contains the workflow.

FOLDER Name of the folder that contains the workflow.

APP Name of the application that you created to extract data from SAP BW OHS.

WORKFLOW Name of the workflow that you created to extract data from SAP BW OHS.

DOMAIN Domain for the Data Integration Service that runs the workflow.

DIS Data Integration Service that runs the workflow.

PowerExchange for SAP NetWeaver Uninstallation
When you uninstall the Developer tool, you also uninstall PowerExchange for SAP NetWeaver. The uninstaller 
does not remove the RFC_INI environment variables.

After you uninstall PowerExchange for SAP NetWeaver, you must clean up the SAP system.

Cleaning Up the SAP System
Perform the following tasks to clean up the SAP system:

Delete transport objects from SAP

Use the SE10 and SE80 transactions to delete the transport objects that you installed to run 
PowerExchange for SAP NetWeaver.
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C h a p t e r  3

SAP BW Service Configuration
This chapter includes the following topics:

• SAP BW Service Overview, 24

• SAP BW Service Properties, 25

• infacmd SAP BW Service Properties, 25

• Creating the SAP BW Service, 28

• Enabling and Disabling the SAP BW Service, 28

• Editing the SAP BW Service Properties, 29

• Viewing Log Events, 29

SAP BW Service Overview
Create an SAP BW Service when you want to read data from or write data to SAP BW. Use Informatica 
Administrator to create and manage the SAP BW Service.

The SAP BW Service is an application service that performs the following tasks:

• Listens for RFC requests from SAP BW.

• Initiates workflows to extract from or load to SAP BW.

• Sends log events to the Log Manager.

Use the Administrator tool to complete the following SAP BW Service tasks:

• Create the SAP BW Service.

• Enable and disable the SAP BW Service.

• Configure the SAP BW Service properties.

• Configure the associated Data Integration Service.

• Configure the SAP BW Service processes.

• Configure permissions for the SAP BW Service.

• View messages that the SAP BW Service sends to the Log Manager.
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SAP BW Service Properties
The following table describes the SAP BW Service properties for the Developer tool:

Property Description

Program ID Program ID for the logical system you create in SAP BW for the SAP BW Service.
The Program ID in SAP BW must match this parameter, including case.

Gateway Host Host name of the SAP gateway.

Gateway Server Server name of the SAP gateway.

SAP Connection SAP connection.
Specify a connection to a specific SAP application server or an SAP load balancing connection.

Trace Use this option to track the JCo calls that the SAP system makes. SAP stores the information 
about the JCo calls in a trace file.
Specify one of the following values:
- 0. Off
- 1. Full
Default is 0.
You can access the trace files from the following directory on the machine where you installed the 
Informatica services:
<Informatica installation directory>/tomcat/bin

Other 
Connection 
Parameters

Enter any other connection parameter that you want to use.
Use the following format:
<parameter name>=<value>

Retry Period Number of seconds the SAP BW Service waits before trying to connect to the SAP BW system if a 
previous connection failed. The SAP BW Service tries to connect five times. Between connection 
attempts, it waits the number of seconds you specify. After five unsuccessful attempts, the SAP 
BW Service shuts down.
Default is 5 seconds.
Note: The Retry Period property is not available when you create the SAP BW Service. You can 
define it when you edit the SAP BW Service properties.

infacmd SAP BW Service Properties
You can create an SAP BW Service with the infacmd isp CreateService command. By default, the SAP BW 
Service is enabled when you create it.

The infacmd isp CreateService command uses the following syntax:

CreateService

<-DomainName|-dn> domain_name

<-UserName|-un> user_name

<-Password|-pd> password

<-ServiceName|-sn> service_name
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<-NodeName|-nn> node_name

<-IntegrationService|-dis> data_integration_service_name

<-RepositoryUser|-mru> model_repository_user

<-RepositoryPassword|-mrp> model_repository_password

[<-ServiceOptions|-so> option_name=value ...]

The following table describes the infacmd isp CreateService options and arguments:

Option Argument Description

-DomainName
-dn

domain_name Required. Name of the Informatica domain. You can 
set the domain name with the -dn option or the 
environment variable INFA_DEFAULT_DOMAIN. If you 
set a domain name with both methods, the -dn option 
takes precedence.

-UserName
-un

user_name Required if the domain uses Native or LDAP 
authentication. User name to connect to the domain. 
You can set the user name with the -un option or the 
environment variable INFA_DEFAULT_DOMAIN_USER. 
If you set a user name with both methods, the -un 
option takes precedence.
Optional if the domain uses Kerberos authentication. 
To run the command with single sign-on, do not set 
the user name. If you set the user name, the 
command runs without single sign-on.

-Password
-pd

password Required if you specify the user name. Password for 
the user name. The password is case sensitive. You 
can set a password with the -pd option or the 
environment variable 
INFA_DEFAULT_DOMAIN_PASSWORD. If you set a 
password with both methods, the password set with 
the -pd option takes precedence.

-ServiceName
-sn

service_name Required. Name of the SAP BW Service.
The name is not case sensitive and must be unique 
within the domain. The characters must be 
compatible with the code page of the associated 
repository. The name cannot have leading or trailing 
spaces, include carriage returns or tabs, exceed 79 
characters, or contain the following characters:

/ * ? < > " |

-NodeName
-nn

node_name Required. Name of the node where you want the SAP 
BW Service process to run. If the Informatica 
environment is configured for high availability, this 
option specifies the name of the primary node.

-ModelRepositoryUser
-mru

model_repository_user Required. User name used to connect to the 
repository.
To enter a name that contains a space or other non-
alphanumeric character, enclose the name in 
quotation marks.
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Option Argument Description

-ModelRepositoryPassword
-mrp

model_repository_password Required if secure communication is not enabled for 
the domain. Optional if secure communication is 
enabled for the domain.
User password. You can set a password with the -rp 
option or the environment variable 
INFA_REPOSITORY_PASSWORD. If you set a 
password with both methods, the password set with 
the -rp option takes precedence.

-DataIntegrationService
-dis

data_integration_service_name Required. Name of the Data Integration Service to 
which the SAP BW Service connects.
To enter a name that contains a space or other non-
alphanumeric character, enclose the name in 
quotation marks.

-LicenseName
-ln

license_name Required if you create an enabled service. Name of 
the license you want to assign to the SAP BW Service.

-ServiceOptions
-so

option_name=value Optional. Service properties that define how the SAP 
BW Service runs.

SAP BW Service Options
Enter SAP BW Service options in the following format:

infacmd CreateService ... -so option_name=value option_name=value ... 

To enter multiple options, separate them with a space. To enter a value that contains a space or other non-
alphanumeric character, enclose the value in quotation marks.

The following table describes the SAP BW Service options:

Option Description

GWHost Host name of the SAP gateway.

GWServ Server name of the SAP gateway.

SAPConnectionRef SAP connection that you want to use.
Specify a connection to a specific SAP application server or an SAP load balancing connection.

ProgramId Program ID for the logical system that you create in SAP BW for the SAP BW Service.
The Program ID in SAP BW must match this parameter, including case.

RetryPeriod Number of seconds the SAP BW Service waits before trying to connect to the SAP BW system if 
a previous connection failed. The SAP BW Service tries to connect five times. Between 
connection attempts, it waits the number of seconds you specify. After five unsuccessful 
attempts, the SAP BW Service shuts down.
Default is 5 seconds.
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Creating the SAP BW Service
Create an SAP BW Service when you want to read data from or write data to SAP BW. Use Informatica 
Administrator to create the SAP BW Service.

1. Log in to the Administrator tool. 

2. In the Domain Navigator, select the domain. 

3. Click Actions > New > SAP BW Service. 

The New SAP BW Service window appears.

4. Configure the SAP BW Service properties. 

5. Click OK. 

The SAP BW Service is created.

Enabling and Disabling the SAP BW Service
Use the Administrator tool to enable and disable the SAP BW Service. You might disable the SAP BW Service 
if you need to perform maintenance on the machine where the SAP BW Service runs. Enable the disabled SAP 
BW Service to make it available again.

Before you enable the SAP BW Service, you must define Informatica as a logical system in SAP BW.

When you enable the SAP BW Service, the service starts. If the service cannot start, the domain tries to 
restart the service based on the restart options configured in the domain properties.

If the service is enabled but fails to start after reaching the maximum number of attempts, the following 
message appears:

The SAP BW Service <service name> is enabled. 
The service did not start. Please check the logs for more information. 

You can review the logs to determine the reason for failure and fix the problem. After you fix the problem, 
disable and re-enable the SAP BW Service to start it.

When you enable the SAP BW Service, it tries to connect to the associated Integration Service. If the 
Integration Service is not enabled and the SAP BW Service cannot connect to it, the SAP BW Service still 
starts successfully. When the SAP BW Service receives a request from SAP BW to start a workflow, the 
service tries to connect to the associated Integration Service again. If it cannot connect, the SAP BW Service 
returns the following message to the SAP BW system:

The SAP BW Service could not find Integration Service <service name> in domain <domain 
name>. 

To resolve this problem, verify that the Integration Service is enabled, and that the domain name and 
Integration Service name that you entered under the third-party details of the InfoPackage are valid. Then, 
restart the process chain in the SAP BW system.

When you disable the SAP BW Service, select one of the following options:

• Complete. Disables the SAP BW Service after all service processes complete.

• Abort. Aborts all processes immediately and then disables the SAP BW Service. You might choose abort if 
a service process stops responding.
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Enabling the SAP BW Service
1. In the Domain Navigator of the Administrator tool, select the SAP BW Service. 

2. Click Actions > Enable Service. 

Disabling the SAP BW Service
1. In the Domain Navigator of the Administrator tool, select the SAP BW Service. 

2. Click Actions > Disable Service. 

The Disable SAP BW Service window appears.

3. Select the disable mode and click OK. 

Editing the SAP BW Service Properties
Use the Properties tab in the Administrator tool to edit the properties for the SAP BW Service.

1. Log in to the Administrator tool. 

2. In the Domain Navigator, select the SAP BW Service. 

3. Click the Properties tab and then click Edit corresponding to the category of properties that you want to 
update. 

4. Update the property values and restart the SAP BW Service for the changes to take effect. 

Viewing Log Events
The SAP BW Service sends log events to the Log Manager. The SAP BW Service captures log events that 
track interactions between the Developer tool and SAP BW.

You can view SAP BW Service log events in the following locations:

• Administrator tool. On the Logs tab, enter search criteria to find log events that the SAP BW Service 
captures when you read data from or write data to SAP BW.

• SAP BW Monitor. In the Monitor - Administrator Workbench window, you can view log events that the SAP 
BW Service captures for an InfoPackage that is included in a process chain to write data into SAP BW. 
SAP BW pulls the messages from the SAP BW Service and displays them in the monitor. The SAP BW 
Service must be running to view the messages in the SAP BW Monitor.

To view log events about how the Data Integration Service processes an SAP BW workflow, view the 
workflow log.
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C h a p t e r  4

SAP Connection
This chapter includes the following topics:

• SAP Connection Overview, 30

• SAP Connection Properties, 30

• Creating an SAP Connection, 32

SAP Connection Overview
Use an SAP connection to access SAP tables in an SAP enterprise application or access SAP BW objects.

Create a connection to import metadata from an SAP table or an SAP BW object. You can then use the 
connection to create a data object, preview data, profile data, and run mappings. The Developer tool uses the 
connection when you import a data object. The Data Integration Service uses the connection when you 
preview data or run mappings.

Use the Developer tool, Administrator tool, or infacmd to create an SAP connection.

SAP Connection Properties
Use an SAP connection to access an SAP table or an SAP BW object. The SAP connection is an enterprise 
application connection. You can create and manage an SAP connection in the Administrator console or the 
Developer tool.

Note: The order of the connection properties might vary depending on the tool where you view them.

The following table describes the SAP connection properties:

Property Description

Username Required. User name for the SAP source system that you want to access.

Password Required. Password for the user name.
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Property Description

Connection type Required. Type of connection that you want to create.
Select one of the following values:
- Application. Create an application connection when you want to connect to a specific SAP 

application server.
- Load balancing. Create a load balancing connection when you want to use SAP load balancing.
Default is Application.
Based on the connection type you select, the corresponding connection property fields become 
available in the Connection Details dialog box. The Developer tool greys out the connection 
property fields that are not applicable for a particular connection type.

Host name Required when you create an SAP application connection.
Host name or IP address of the SAP server that you want to connect to.

System number Required when you create an SAP application connection.
SAP system number.

Message host 
name

Required when you create an SAP load balancing connection.
Host name of the SAP message server.

R3 name/SysID Required when you create an SAP load balancing connection.
Name of the SAP system.

Group Required when you create an SAP load balancing connection.
Group name of the SAP application server.

Client Required. SAP client number.

Language Optional. Language that you want to use for mappings and workflows.
Must be compatible with the Developer tool code page.
If you leave this option blank, the Developer tool uses the default language of the SAP system.

Trace Optional. Use this option to track the JCo calls that the SAP system makes. SAP stores the 
information about the JCo calls in a trace file.
Specify one of the following values:
- 0. Off
- 1. Full
Default is 0.
You can access the trace files from the following directories:
- <Informatica installation directory>/tomcat/bin directory on the machine where 

you installed the Informatica services
- <Informatica installation directory>/clients/DeveloperClient directory on the 

machine where you installed the Developer tool

Additional 
parameters

Optional. Enter any other connection parameter that you want to use.
Use the following format:
<parameter name>=<value>

Staging directory Path in the SAP system where the stage file will be created.

Source directory Path that contains the source file. The path must be accessible to the Data Integration Service.

Use FTP Enables FTP access to SAP.
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Property Description

FTP user Required when you use FTP.
User name to connect to the FTP server.

FTP password Required when you use FTP.
Password for the FTP user.

FTP host Required when you use FTP.
Host name or IP address of the FTP server.
Optionally, you can specify a port number from 1 through 65535, inclusive. Default for FTP is 21.
Use one of the following syntax to specify the host name:
- hostname:port_number
- IP address:port_number
When you specify a port number, enable that port number for FTP on the host machine.
If you enable SFTP, specify a host name or port number for an SFTP server. Default for SFTP is 22.

Retry period Number of seconds that the Data Integration Service attempts to reconnect to the FTP host if the 
connection fails.
If the Data Integration Service cannot reconnect to the FTP host in the retry period, the mapping or 
workflow fails.
Default is 0. A value of 0 indicates an infinite retry period.

Use SFTP Enables SFTP access to SAP.

Public key file 
name

Required when you enable SFTP and the SFTP server uses public key authentication.
Public key file path and file name.

Private key file 
name

Required when you enable SFTP and the SFTP server uses public key authentication.
Private key file path and file name.

Private key file 
name password

Required when you enable SFTP, and the SFTP server uses public key authentication and the 
private key is encrypted.
Password to decrypt the private key file.

Port range for 
HTTP

HTTP port range that the Data Integration Service must use to read data from the SAP server in 
streaming mode.
Enter the minimum and maximum port numbers with a hyphen as the separator. The minimum and 
maximum port number can range between 10000 and 65535. You can also specify the port range 
according to your organization.
Default is 10000-65535.

Creating an SAP Connection
Before you import SAP data objects, preview data, profile data, or run mappings and workflows, create an 
SAP connection.

1. Click Window > Preferences. 

2. Select Informatica > Connections. 

3. Expand the domain. 
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4. Select Enterprise Application > SAP, and then click Add. 

Note: Effective in version 10.2, Informatica dropped support for the RFC SDK based SAP Table Reader 
connections. Informatica deprecated these connections in version 10.0. If you upgrade from versions 
earlier than 10.2, then you must configure a new SAP Table Reader connection using the SAP JCo 
libraries.

5. Enter a connection name. 

6. Optionally, enter a connection ID and description. 

7. Select the domain where you want to create the connection. 

8. Click Next. 

9. Configure the connection properties. 

10. Click Test Connection to verify that the connection to the SAP system is successful. 

11. Click Finish. 
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Part II: SAP Table Data Extraction
This part contains the following chapters:

• Introduction to SAP Table Data Extraction, 35

• Building Informatica Objects for SAP Table Data Extraction, 38
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C h a p t e r  5

Introduction to SAP Table Data 
Extraction

This chapter includes the following topics:

• SAP Table Data Extraction Overview, 35

• Staging Mode, 35

• Streaming Mode, 37

• Compressed Data Transfer, 37

SAP Table Data Extraction Overview
You can use PowerExchange for SAP NetWeaver to read data from SAP tables and views. You can configure 
the Data Integration Service to read data from transparent, pool, and cluster tables.

You can use staging or streaming mode to extract data from the SAP tables.

Staging Mode
You can run SAP mappings in staging mode when the data set is large.

When you run a mapping in staging mode, the Developer tool creates a stage file on the SAP application 
server. The Data Integration Service reads SAP source data, loads it into a stage file, and continues to 
process the mapping. The Data Integration Service then deletes the stage file unless you configure the 
mapping to reuse the stage file.

Mappings that are run in staging mode do not require an online connection between the Data Integration 
Service and SAP while the Developer tool is reading data. For this reason, you can run mappings offline by 
using a background process. Configure background processing when the data volume is high and the reading 
time exceeds the limit for dialog processes.

Stage File Reuse
When you run a mapping in staging mode, the SAP application server creates a stage file for each data object 
operation in the mapping. By default, the Data Integration Service deletes the file after reading it. When you 
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run multiple mappings that use identically configured data object operations, you can save the stage files and 
reuse them for another mapping.

To reuse the stage files, configure the following advanced properties when you read data from SAP:

Persist Stage File

When you configure the Data Integration Service to persist the stage file, the Data Integration Service 
connects to the FTP location where you save the stage file and reads the existing file. Also, the Data 
Integration Service does not delete the stage file from the FTP location.

Reinitialize Stage File

When you configure the Data Integration Service to reinitialize the stage file, the Data Integration Service 
reads data from the SAP tables and replaces the existing stage file in the FTP location. Use this option 
when the source data has changed or when you want to refresh the stage file.

The following table describes the Data Integration Service actions for the stage file persistence and 
reinitialization options:

Persist the 
Stage file

Reinitialize the 
Stage file

Action

On Off The Data Integration Service creates a stage file in the FTP location if the file does 
not exist. If the stage file exists, the Data Integration Service validates and reuses 
the file. If the validation fails, the Data Integration Service recreates the file. The 
Data Integration reads the stage file and the file remains in the FTP location for 
reuse.

On On The Data Integration Service reads data from the SAP tables and overwrites the 
existing stage file with the data from SAP. Then, the Data Integration Service 
retains the stage file in the FTP location for reuse.

Off Off The Data Integration Service reads the stage file and deletes the file.

Modes of Access
You can access stage files for SAP mappings in the following ways:

• NFS Mount

• FTP or SFTP

NFS Mount
Use an NFS mount when the file path and name are different for the SAP system and the Data Integration 
Service.

Use an NFS mount in the following situations:
One host is Windows and the other is UNIX

Map a drive from the Data Integration Service to the machine where the stage files reside. The path 
names map differently between the two platforms.

The file system shared between the two hosts are mounted differently

Map a drive from the Data Integration Service to the machine where the stage files reside.

The user accessing the file must be the user that runs the Data Integration Service. If the SAP system is on 
Windows, the user must have standard read permissions on the directory where you stage the file.
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FTP or SFTP
Use FTP or SFTP when the Data Integration Service accesses the file system through an FTP or SFTP 
connection. Use FTP or SFTP in the following situations:

The FTP or SFTP server is configured to view the entire file system

When the Data Integration Service accesses SAP through FTP or SFTP, the path to the file is identical.

The FTP or SFTP server is restricted to a certain directory or directories

The paths for the staging directory and source directory are different.

The user who accesses the stage file must be the FTP or SFTP user. If the SAP system is on Windows, the 
user must have standard read permissions on the directory where you stage the file.

If the Data Integration Service fails to access the stage file through FTP or SFTP, it logs the error message 
returned by SAP in the workflow log. Use transaction ST22 from the SAP client to get more information about 
the SAP error message.

Streaming Mode
PowerExchange for SAP NetWeaver uses HTTP to run mappings in streaming mode.

When you run a mapping in streaming mode, PowerExchange for SAP NetWeaver starts an HTTP session and 
requests data from SAP. SAP streams data over the HTTP protocol to the Data Integration Service.

Compressed Data Transfer
File compression helps in improving the mapping performance and processing the data more efficiently.

When you run a mapping in staging mode, SAP compresses the source data and loads the data to a stage 
file. The Data Integration Service then reads the compressed data from the stage file and writes it to the 
target. Compression helps in increasing the data transfer speed and decreasing the amount of disk storage 
that the stage file needs. Therefore, the mapping performance improves.
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C h a p t e r  6

Building Informatica Objects for 
SAP Table Data Extraction

This chapter includes the following topics:

• Informatica Objects for SAP Table Data Extraction Overview, 38

• Importing an SAP Table Data Object, 39

• SAP Table Data Object Properties, 40

• Creating an SAP Table Data Object Read Operation, 41

• SAP Table Data Object Read Operation Properties, 41

• Output Properties of an SAP Table Data Object Read Operation, 41

• SAP Table Data Extraction Mapping, 45

• Parameterization, 45

• Partitioning, 46

Informatica Objects for SAP Table Data Extraction 
Overview

An SAP Table data object is a physical data object that uses an SAP resource as a source or lookup. You can 
create an SAP Table data object based on a view or a transparent, pool, or cluster table.

To create an SAP Table data object, create an SAP connection in the Developer tool and import an SAP table 
from the SAP system. Create a data object read operation based on the SAP Table data object. You can 
define the read operation properties to specify how the Data Integration Service must read data from the SAP 
system. You can then add the read operation as a source or lookup to a mapping, mapplet, or profile.

After you create the data object read operation, you can run the mapping to read or look up data from the 
SAP system. You can create multiple data object operations for an SAP Table data object.
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Importing an SAP Table Data Object
Import an SAP Table data object to specify the SAP table or view from which you want to read data. You can 
then create a data object read operation based on the data object, and add the read operation to a mapping, 
mapplet, or profile.

1. Select a project or folder in the Object Explorer view. 

2. Click New > Data Object. 

3. Select SAP Table Data Object and click Next. 

Note: Effective in version 10.2, Informatica dropped support for data object of type SAP Data Object 
(Deprecated). Informatica deprecated these objects in version 10.0. If you upgrade from versions earlier 
than 10.2, then you must create a new data object of type SAP Table Data Object to read data from SAP 
tables.

The New SAP Table Data Object dialog box appears.

4. Click Browse next to the Location option and select the target project or folder. 

5. Click Browse next to the Connection option and select an SAP connection from which you want to 
import the SAP table metadata, and then click OK. 

6. To add a table to the SAP Table data object, click Add next to the Resource option. 

Importing an SAP Table Data Object       39



The Add Resource dialog box appears.

7. On the left pane, expand the connection, and click Tables/Views. 

A list of tables appears on the right pane.

8. Select a table or search for the table to add to the data object: 

• To import an SAP table from the list, select the table and click OK.

• To search for a table based on a name, enter a name in the Name field. To search for a table based 
on a description, click Go > Advanced, and add a description. Select the table and click OK.

When you search for a table by the name, you can include wildcard characters and separate multiple 
table names with a comma.

The New SAP Table Data Object dialog box appears.

9. If required, add additional tables to the SAP Table data object. 

10. Optionally, enter a name for the SAP Table data object. 

11. Click Finish. 

The data object appears under Physical Data Objects in the project or folder in the Object Explorer view.

You can also add tables to an SAP Table data object after you create it.

SAP Table Data Object Properties
After you create an SAP Table data object, you can edit the data object properties in the Overview view. The 
Overview properties include general properties that apply to the SAP Table data object. They also include 
object properties that apply to the SAP table that you import.

General Properties

You can configure the following general properties for an SAP Table data object:

• Name. Name of the SAP Table data object.

• Description. Description of the SAP Table data object.

• Connection. Name of the SAP connection. Click Browse to select a different SAP connection or 
parameterize the connection.

Object Properties

You can configure the following general properties, column properties, and advanced properties for the 
SAP table you add in the table data object:

• Name. Name of the SAP table.

• Description. Description of the SAP table.

• Native Name. Name of the SAP table including the entity in which the table exists. You can 
parameterize the native name.

• Path Information. Path to the SAP table.

• Column Properties. Column properties include name, native name, data type, precision, and 
description of the columns in the SAP table. You can also define the primary key.

• Keys. Enter a primary key name and select the key columns.
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Creating an SAP Table Data Object Read Operation
Create an SAP Table data object read operation based on an SAP Table data object. You can then add the 
read operation as a source or lookup in a mapping.

1. Select the SAP Table data object in the Object Explorer view. 

2. Right-click the SAP Table data object and select New > Data Object Operation. 

The Data Object Operation dialog box appears.

3. Enter a name for the data object read operation. 

4. Select the operation type as tableRead from the Capabilities. 

Note: The tableWrite operation type is reserved for future use.

5. Click Add. 

The Select Resources dialog box appears.

6. Select the SAP table for which you want to create the data object read operation, and then click OK. 

7. Click Finish. 

The Developer tool creates the read operation for the selected SAP Table data object.

SAP Table Data Object Read Operation Properties
The Data Integration Service reads data from the SAP table based on the data object read operation 
properties that you specify.

When you create a data object read operation, the Developer tool creates a Source transformation and an 
Output transformation. The Source transformation is named after the SAP table and represents the data that 
the Data Integration Service reads from the SAP table. Select the Source transformation to view data such as 
the name and description of the SAP resource.

The Output transformation represents the data that the Data Integration Service passes into the mapping 
pipeline. Select the Output transformation to edit the ports, sources, query, run-time, and advanced 
properties.

Output Properties of an SAP Table Data Object Read 
Operation

The Output transformation defines the run-time properties that the Data Integration Service uses to read data 
from the SAP table.

You can configure the Output transformation to perform the following tasks:

• Edit the ports properties.

• Define a join condition.

• Define a filter condition.

• Define a sort condition.
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• Change or parameterize the SAP connection.

• Set the partition type.

Ports Properties
The port properties list the name, data type, precision, scale, and description for all the ports that the data 
object read operation contains.

You can configure the following ports properties in the data object read operation:

Property Description

Name Name of the port.

Type Data type of the port.

Precision Maximum number of digits for numeric data types or maximum number of characters for string data 
types. The precision includes the scale for numeric values.

Scale Maximum number of digits after the decimal point for numeric values.

Description Description of the port.

Query Properties
You can use the Query tab to configure the following properties in the data object read operation:

• Join condition

• Filter condition

• Sorting

Join
When you have two or more tables in a data object read operation, you can specify a join condition to join 
data from multiple tables.

You can configure an inner join or a left join.

The following table describes the properties that you can specify when you configure a join condition:

Property Description

Joiner Condition The type of join that you want to configure.
Select one of the following options:
- Inner join
- Left join

Platform Expression The expression that you use to join tables.

Left Field The SAP column on which you want to apply the join condition.
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Property Description

Operator Simple operators that you can use to join tables.
You can select one of the following operators:
=, >, >=, <, <=, !=

Right Field The value you specify to join the SAP tables.

The following restrictions apply when you use an SAP Table data object to read data from SAP tables:

• You cannot join more than one SAP cluster or pool table.

• You cannot use a left join with a filter condition to join two or more transparent SAP tables.

• You cannot use a left join to join a transparent table and a cluster or pool table.

Filter
Use a filter to reduce the number of rows that the Data Integration Service reads from the SAP source table. 
When you enter a source filter, the Developer tool adds a WHERE clause to the default query.

You can configure the following types of filter conditions:
Native Expression

Use the following syntax to enter a native expression filter condition:

• Syntax for single filter condition

TABLE1~FIELD1 = 'value'
• Syntax for multiple filter conditions

TABLE1~FIELD1 = 'value' OR/AND TABLE1~FIELD1 = ‘value2’
• Syntax for multiple table conditions

TABLE1~FIELD1 = 'value' AND TABLE2~FIELD2 = ‘value2’
Note: By default, when you double-click a column name, the expression editor displays the filter 
condition in the following format: 

TABLENAME.FIELDNAME
Before you define a value for the filter condition, you must change the format as follows:

TABLENAME~FIELDNAME
Platform Expression

You can use the platform filter expression to select specific tables from SAP sources based on the filter 
condition that you specify.

The following table describes the properties that you can specify when you use the platform expression filter:

Property Description

Expression Type The type of filter expression that you want to use to filter tables.

Left Field The SAP column on which you want to apply the filter condition.
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Property Description

Operator Simple operators you can use to filter tables.
You can select one of the following operators:
=, >, >=, <, <=, !=

Right Field The value you specify to filter the SAP tables.

Sorting
Use sorted ports to sort column data in an SAP data object. When you use sorted ports, the Developer tool 
adds an ORDER BY clause to the SQL query. The SAP system performs the query and passes the resulting 
data to the Data Integration Service.

When you use the SAP data object as a read operation in a mapping or mapplet, you can send sorted data 
from the read operation to the downstream transformations.

Note: In an SAP Table data object, you cannot use sorted ports to sort rows on SAP cluster and pool tables.

Run-time Properties
You can use the Run-time tab to change or parameterize the SAP connection, and configure partitioning.

The run-time properties display the name of the connection that the Data Integration Service uses to read 
data from the SAP table. You can select a different connection or parameterize the connection.

You can also configure key range partitioning to optimize the mapping performance. When you configure key 
range partitioning, the Data Integration Service distributes rows of data based on a port or set of ports that 
you define as the partition key. You define a range of values for each port. The Data Integration Service uses 
the key and ranges to send rows to the appropriate partition.

Advanced Properties
The advanced properties determine how the Data Integration Service reads data from the SAP tables.

You can configure the following advanced properties for an SAP Table data object read operation:
Data transfer mode

You can transfer data in staging or streaming mode.

When you run a mapping in staging mode, the Developer tool creates a stage file on the SAP application 
server. The Data Integration Service reads source data and loads it into the stage file.

When you run a mapping in streaming mode, PowerExchange for SAP NetWeaver starts an HTTP session 
and requests data from SAP. SAP streams data over the HTTP protocol to the Data Integration Service.

Number of rows to fetch

You can enter the maximum number of rows that you want to fetch from the SAP table. The Data 
Integration Service then fetches data based on the number of rows you enter.

Number of rows to skip

You can enter the number of rows that you want to skip in an SAP table. The Data Integration Service 
then skips those rows that you entered and fetches the remaining rows.

For example, you can set this property to 10 to skip the first 10 rows in an SAP resource and read from 
the eleventh row.
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Run in background

You can choose to run a mapping in the background when the data volume is high and the Data 
Integration Service takes a very long time to read data from the SAP tables.

Stage file name

Name of the stage file. You can assign parameters to the stage file name.

Reinitialize the stage file

When you select the Reinitialize the stage file option, the Data Integration Service reads data and 
replaces the existing files. You can reinitialize the stage file when the source data has changed and you 
want to refresh the source data.

If you reinitialize the stage file without persisting it, the Data Integration Service reinitializes the stage 
file and deletes the stage file after reading it.

If you reinitialize and persist the stage file simultaneously, the Data Integration Service does not delete 
the stage file after reading the file.

Persist the stage file

When you select the Persist the stage file option, the Data Integration Service connects to the stage file 
directory where you saved the stage file and reads the file.

If you disable the Persist the stage file option, the Data Integration Service deletes the stage file from 
the stage file directory after reading it.

SAP Table Data Extraction Mapping
After you create an SAP Table data object read operation, you can create a mapping. You can add the data 
object read operation as a source or lookup in the mapping. You can then add transformations and a target in 
the mapping.

Validate and run the mapping. You can also add the mapping to a Mapping task in a workflow and run the 
workflow.

Parameterization
You can use parameters to change the connection and SAP Table data object read operation properties at 
run time.

You can parameterize the following data object read operation properties:

• Data transfer mode

• Number of rows to fetch

• Number of rows to skip

• Stage file name

• Filter condition
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Partitioning
When you read data from SAP, you can configure partitioning to optimize the mapping performance at run 
time. The partition type controls how the Data Integration Service distributes data among partitions at 
partition points.

You can define the partition type as key range partitioning. When you configure key range partitioning, the 
Data Integration Service distributes rows of data based on a port or set of ports that you define as the 
partition key. You can define a range of values for each port. The Data Integration Service uses the key and 
ranges to send rows to the appropriate partition.
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Part III: SAP BW OHS Data 
Extraction

This part contains the following chapters:

• Introduction to SAP BW OHS Data Extraction, 48

• Building SAP Objects for BW OHS Data Extraction, 50

• Building Informatica Objects for BW OHS Data Extraction, 53

• Extracting Data from SAP BW OHS, 59
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C h a p t e r  7

Introduction to SAP BW OHS Data 
Extraction

This chapter includes the following topics:

• SAP BW OHS Data Extraction Overview, 48

• SAP BW OHS Data Extraction Process Flow, 48

• Raw Data Transfer, 49

SAP BW OHS Data Extraction Overview
You can use PowerExchange for SAP NetWeaver to read data from SAP BW through an Open Hub Destination 
(OHD) or InfoSpoke.

An open hub destination is an SAP object that you use to distribute data from the SAP BW system to other 
SAP and non-SAP applications, and third-party tools. You can create an open hub destination based on BW 
objects such as InfoCubes, DataStore objects, InfoObjects, and InfoSets.

An InfoSpoke provides the same functionality as an open hub destination. It defines the open hub data 
source from which you want to extract the data, the extraction mode, and the open hub destination to which 
you want to write the data. Effective in SAP BW version 7.0, SAP does not support InfoSpokes and 
recommends using open hub destinations instead. For this reason, Informatica also recommends using open 
hub destinations instead of InfoSpokes.

To extract data from SAP BW, you must complete configuration tasks on both the SAP and Informatica 
systems. You must trigger the data extraction from SAP.

SAP BW OHS Data Extraction Process Flow
To read data from SAP BW, you must complete configuration tasks on both the SAP and Informatica 
systems.

1. Create an open hub destination in SAP to read data from SAP BW.

2. Create a transformation in SAP to map the source and target fields. The source is the SAP object from 
which you want to read data. The target is the open hub destination to which you want to extract the 
data.

48



3. Create a Data Transfer Process (DTP) in SAP to extract the data from SAP BW and write it to an SAP 
transparent table.

4. In Informatica Developer, create an SAP connection and use the connection to import an SAP BW OHS 
Extract data object. You can create an SAP BW OHS Extract data object based on an open hub 
destination or InfoSpoke.

5. Create a data object read operation based on the SAP BW OHS Extract data object.

6. Define the read operation properties to determine how the Data Integration Service must read data from 
SAP BW.

7. Create a mapping with the read operation as the source.

8. Create a workflow based on the mapping.

9. Create an application based on the workflow and deploy the application to the Data Integration Service.

10. Create and start an SAP BW Service.

11. Configure the Informatica system details under the third-party details in SAP. Enter the workflow name, 
application name, project name, and folder name. You can also use the Informatica command line 
program to define the third-party details in SAP.

12. Initiate the data extraction from SAP. You can either start the data extraction immediately or schedule to 
run it a later time.
To schedule the data extraction, create and start a process chain in SAP to read data from the open hub 
destination and store it in a BW table. The open hub destination then sends a notification to the SAP BW 
Service stating that the extraction is complete.

The SAP BW Service triggers the application and workflow that you defined under the third-party details 
in SAP.

The Data Integration Service then extracts the data from SAP BW. You can view log events to track the 
interactions between Informatica and SAP BW.

Raw Data Transfer
You can configure the Data Integration Service to read data from SAP BW through the raw data transfer API. 
The mapping performance increases when you read data through the raw data transfer API.

To read data through the raw data transfer API, you must install SAP BW version 7.3 Support Package 5 or 
later.

Raw Data Transfer       49



C h a p t e r  8

Building SAP Objects for BW OHS 
Data Extraction

This chapter includes the following topics:

• SAP Objects for BW OHS Data Extraction Overview, 50

• Creating an Open Hub Destination, 51

• Creating a Transformation, 51

• Creating a Data Transfer Process, 52

SAP Objects for BW OHS Data Extraction Overview
You must create objects in the SAP system to read data from SAP BW.

Create the following objects in the SAP system:

Open Hub Destination

Create an Open Hub Destination (OHD) in SAP to read data from BW. You can create an OHD based on 
InfoCubes, DataStore objects, InfoObjects, and InfoSets.

Transformation

Create a transformation in SAP to map the source fields to the target fields. The source is the SAP 
object from which you want to read data. The target is the open hub destination to which you want to 
extract the data.

Data Transfer Process

Create a Data Transfer Process (DTP) in SAP to extract the data from SAP BW and write it to an SAP 
transparent table.
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Creating an Open Hub Destination
Create an open hub destination in SAP to extract data from SAP BW. You can configure SAP BW objects such 
as InfoCubes, DataStore Objects, InfoObjects, and InfoSets as open hub destination data sources.

1. On the SAP User Menu screen, enter RSA1 in the Transaction field. 

The Administrator Workbench opens.

2. On the left pane, click Open Hub Destination. 

3. On the right pane, right-click an InfoArea and select Create Open Hub Destination. 

The Create Open Hub Destination dialog box appears.

4. On the General tab, select the data source from which you want to extract data. 

5. Enter a name and description for the open hub destination. 

6. Select the object type from which you want to extract the data to the open hub destination. 

7. Select the object from which you want to extract data and then click Enter. 

The open hub destination is added to the InfoArea.

8. On the Destination tab, select the destination as Third-Party Tool. 

9. Enter an RFC destination. 

10. Save and activate the open hub destination. 

Creating a Transformation
Create a transformation in SAP to map the source fields to the target fields. The source is the SAP object 
from which you want to read data. The target is the open hub destination to which you want to extract the 
data.

1. On the SAP User Menu screen, enter RSA1 in the Transaction field. 

The Administrator Workbench opens.

2. On the left pane, right-click the source for which you want to create the transformation and select Create 
Transformation. 

The Create Transformation dialog box opens.

3. Under the Target of the Transformation section, select the target object type. 

4. Enter the name of the target object. 

5. Under the Source of the Transformation section, select the source object type. 

6. Enter the name of the source object and the source system. 

7. Click Enter. 

The SAP system proposes a transformation that maps the source fields to the target fields. You can 
either use the proposed transformation or edit it based on your requirements.

8. Save and activate the transformation. 
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Creating a Data Transfer Process
Create a Data Transfer Process (DTP) to transfer data from source objects to target objects in SAP BW.

1. Open the Administrator Workbench. 

2. Right-click the open hub destination and select Create Data Transfer Process. 

The Creation of Data Transfer Process dialog box appears.

3. Enter a name for the DTP in the Data Transfer Proc field. 

4. Select the object type and the name of the source that you specified for the open hub destination. 

5. Save and activate the DTP. 
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C h a p t e r  9

Building Informatica Objects for 
BW OHS Data Extraction

This chapter includes the following topics:

• Informatica Objects for BW OHS Data Extraction Overview, 53

• Importing an SAP BW OHS Extract Data Object, 54

• SAP BW OHS Extract Data Object Properties, 55

• Creating an SAP BW OHS Extract Data Object Read Operation, 55

• SAP BW OHS Extract Data Object Read Operation Properties, 56

• Output Properties of an SAP BW OHS Extract Data Object Read Operation, 56

• Parameterization, 57

• Partitioning, 57

• SAP BW OHS Mapping, Workflow, and Application Configuration, 58

Informatica Objects for BW OHS Data Extraction 
Overview

To read data from SAP BW, you must create an SAP BW OHS Extract data object. An SAP BW OHS Extract 
data object is a physical data object that uses an SAP BW object as the source.

To create an SAP BW OHS Extract data object, import metadata from an open hub destination or InfoSpoke 
into the Developer tool. Create a data object read operation based on the data object. Then, configure the 
read operation properties to determine how the Data Integration Service must read data from SAP BW.

After you configure a read operation, you can create a mapping to read data from SAP BW. Add the read 
operation as a source in the mapping. You can then add transformations and a target in the mapping.

Create a workflow based on the mapping. Then, create an application based on the workflow and deploy the 
application to the Data Integration Service.

53



Importing an SAP BW OHS Extract Data Object
Import an SAP BW OHS Extract data object to specify the SAP BW object from which you want to read data. 
You can read data from an open hub destination or InfoSpoke. You can then create a data object read 
operation based on the data object.

1. Select a project or folder in the Object Explorer view. 

2. Click File > New > Data Object. 

3. Select SAP BW OHS Extract Data Object and click Next. 

The New SAP BW OHS Extract Data Object dialog box appears.

4. Enter a name for the data object. 

5. Click Browse next to the Location option and select the target project or folder. 

6. Click Browse next to the Connection option and select the SAP connection from which you want to 
import the metadata of the open hub destination or InfoSpoke. 

7. To add a resource, click Add next to the Selected Resources option. 

The Add Resource dialog box appears.

8. On the left pane, expand the connection name. 

• To import an open hub destination, select the Open Hub Destination option on the left pane. A list of 
open hub destination resources appear on the right pane. Select the resource that you want to import.

• To import an InfoSpoke, expand the InfoSpoke option and select the object type on the left pane. A 
list of resources of the selected object type appear on the right pane. Select the resource that you 
want to import.

You can also search for a resource by entering the resource name in the Name field.
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9. Click OK. 

10. Click Finish. 

The data object appears under Physical Data Objects in the project or folder in the Object Explorer view.

SAP BW OHS Extract Data Object Properties
The Overview view of the SAP BW OHS Extract data object displays general information about the data object 
and the properties of the SAP BW resource that you import.

General Properties

You can configure the following general properties for an SAP BW OHS Extract data object:

• Name. Name of the SAP BW OHS Extract data object.

• Description. Description of the SAP BW OHS Extract data object.

• Connection. Name of the SAP connection. Click Browse to select a different SAP connection. You can 
also parameterize the connection.

Object Properties

You can configure the following general properties and column properties for the SAP BW resource that 
you add in the data object:

• Name. Business name of the SAP BW resource.

• Description. Description of the SAP BW resource.

• Native Name. Name of the SAP BW resource. You can also parameterize the native name.

• Path Information. Path to the SAP BW resource.

• Column Properties. Name, native name, data type, precision, scale, and description of the columns in 
the SAP BW resource.

Creating an SAP BW OHS Extract Data Object Read 
Operation

Create an SAP BW OHS Extract data object read operation from an SAP BW OHS Extract data object. You can 
then add the read operation as a source in a mapping.

1. Select the SAP BW OHS Extract data object in the Object Explorer view. 

2. Right-click the data object and select New > Data Object Operation. 

The Data Object Operation dialog box appears.

3. Enter a name for the data object read operation. 

4. Click Add. 

The Select Resources dialog box appears displaying the data object.

5. Select the data object and click OK. 
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6. Click Finish. 

The Developer tool creates the read operation for the selected SAP BW OHS Extract data object.

SAP BW OHS Extract Data Object Read Operation 
Properties

The Data Integration Service reads data from the SAP BW resource based on the data object read operation 
properties that you specify.

When you create a data object read operation, the Developer tool creates a Source transformation and an 
Output transformation. The Source transformation is named after the SAP BW resource and represents the 
data that the Data Integration Service reads from the resource. Select the Source transformation to view data 
such as the name and description of the SAP BW resource.

The Output transformation represents the data that the Data Integration Service passes into the mapping 
pipeline. Select the Output transformation to edit the ports, run-time, and advanced properties.

Output Properties of an SAP BW OHS Extract Data 
Object Read Operation

The Output transformation defines the run-time properties that the Data Integration Service uses to read data 
from the SAP BW resource.

You can configure the Output transformation to perform the following tasks:

• Edit the port properties.

• Change or parameterize the SAP connection.

• Configure partitioning.

• Define the advanced properties that the Data Integration Service must use to read data.

Ports Properties
The ports properties list the name, data type, precision, scale, and description for all the ports that the data 
object read operation contains.

You can configure the following ports properties in the data object read operation:

Property Description

Name Name of the port.

Type Data type of the port.

Precision Maximum number of digits for numeric data types or maximum number of characters for string data 
types. The precision includes the scale for numeric data types.
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Property Description

Scale Maximum number of digits after the decimal point for numeric values.

Description Description of the port.

Run-time Properties
The run-time properties display the name of the connection that the Data Integration Service uses to read 
data from the SAP BW resource. You can select a different connection or parameterize the connection.

You can also use the Run-time tab to configure partitioning. You can configure dynamic partitioning or fixed 
partitioning.

Advanced Properties
The advanced properties determine how the Data Integration Service reads data from the SAP BW resource.

You can configure the following advanced properties in the data object read operation:

Raw Data Transfer

Select this option to enable raw data transfer and increase the mapping performance. When you enable 
raw data transfer, the Data Integration Service reads data from the SAP BW resource through a data 
transfer API.

To read data in the raw format, you must install SAP BW version 7.3 Support Package 5 or later.

Log Lock Retry Count

Number of attempts to acquire a lock to write to the log.

Default is 10000 and the maximum value is 2147483645.

If you do not enable raw data transfer, set the value to 300.

Parameterization
You can parameterize the SAP connection and the log lock retry count property to override the mapping 
properties at run time.

Partitioning
When you read data from SAP BW, you can configure partitioning to optimize the mapping performance. The 
partition type determines how the Data Integration Service distributes data among partitions at partition 
points.

You can configure the following types of partitioning:
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Dynamic partitioning

When you configure dynamic partitioning, the Data Integration Service determines the number of 
partitions that it must create at run time. It scales the number of partitions based on factors such as the 
maximum parallelism value defined for the Data Integration Service and the mapping, and the number of 
CPUs available on the nodes where the mappings run.

For more information about configuring the maximum parallelism value, see the Informatica Application 
Services Guide and the Informatica Developer Mapping Guide.

Fixed partitioning

When you configure fixed partitioning, you must specify the number of partitions that the Data 
Integration Service must create at run time.

SAP BW OHS Mapping, Workflow, and Application 
Configuration

After you create a mapping with an SAP BW OHS Extract data object, you must create a workflow. Then, 
create an application and deploy the workflow as an application to the Data Integration Service.

You must then enter initiate the data extraction from SAP. To initiate the data extraction, open the 
InfoPackage in the SAP system, and enter the following details under the 3rd Party Selections tab:

• Workflow name

• Application name

• Folder name
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C h a p t e r  1 0

Extracting Data from SAP BW 
OHS

This chapter includes the following topics:

• Data Extraction from SAP BW OHS Overview, 59

• Configuring and Starting a Process Chain from SAP BW, 59

• BW OHS Data Extraction Status, 66

Data Extraction from SAP BW OHS Overview
After you complete configuration tasks in the SAP BW and Informatica systems, you must initiate the data 
extraction from SAP.

Configure and start a process chain in SAP to extract data from the SAP BW system. You can either start the 
data extraction immediately or schedule to run it at a later time.

You can view the data extraction status from both SAP and Informatica.

Configuring and Starting a Process Chain from SAP 
BW

To configure and start a process chain in SAP BW, perform the following tasks:

1. Create a process chain and insert the start process.

2. Insert the ZPMSENDSTATUS ABAP program.

3. Insert an InfoSpoke process.

4. Start the process chain.
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Creating the Process Chain and Inserting the Start Process
When you create the process chain and insert the start process, you also schedule the process chain.

1. From the Administrator Workbench in SAP BW, click SAP Menu > Administration > RSPC - Process 
Chains. 

The Process Chain Maintenance Planning View window appears.

2. Click Create. 

The New Process Chain dialog box appears.

3. Enter a unique name for the process chain and enter a description. 

4. Click Enter. 

The Insert Start Process dialog box appears.

5. Click Create. 

The Start Process dialog box appears.

6. Enter a unique name for the start process variant and enter a description. 

7. Click Enter. 

The Maintain Start Process window appears.

8. Click Change Selections to schedule the process chain. 

The Start Time window appears.

9. To schedule the process chain to run immediately after you execute it, click Immediate. 

10. Click Save. 

11. In the Maintain Start Process window, click Cancel. 

12. In the Insert Start Process dialog box, click Enter. 

The start process appears in the Process Chain Maintenance Planning View window.

Inserting the ZPMSENDSTATUS ABAP Program
Before you insert the ZPMSENDSTATUS ABAP program into a process chain, import the program into SAP 
BW.

1. In the Process Chain Maintenance Planning View window in SAP BW, click Process Types. 

2. From the Process Types menu, click General Services > ABAP Program. 

The Insert ABAP Program dialog box appears.

3. Click Create. 

The ABAP Program dialog box appears.

4. Enter a unique name for the ABAP program process variant and enter a description. 

5. Click Enter. 

The Process Maintenance: ABAP Program window appears. 

6. In the Program Name field, click the Browse button to select the ZPMSENDSTATUS ABAP program. 

7. Click Change next to the Program Variant field. 

The ABAP: Variants - Initial Screen window appears.

8. Click Create. 

9. In the ABAP: Variants dialog box, enter a name for the ABAP variant and click Create. 

The Maintain Variant window appears.
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10. In the Maintain Variant window, enter the Maintain Variant fields. 

The following table describes the Maintain Variant fields:

Field Description

DEST Select the name of the RFC destination.

INFPARAM Enter the name of the workflow that you created to extract SAP BW data. Enter the name in one 
of the following formats:
- <Workflow name>
- <Folder name>: <Workflow name>
- <Folder name>: <Workflow name>: <Application name>

CONTEXT Enter OHS API.

INFOPAK Leave this field blank.

OHDEST Value you specified for the Destination field when you created the InfoSpoke.

11. Click Save and Exit in the Maintain Variant window. 

12. Click Save and Exit in the ABAP Variants window. 

13. Click Save and Exit in the Process Maintenance: ABAP Program window. 

14. Click Enter in the Insert ABAP Program dialog box. 

The ABAP program appears in the Process Chain Maintenance Planning View window.

15. Link the Start process to the ZPMSENDSTATUS ABAP program. 

16. Enter the selection criteria to specify the process chains that you want to monitor and click Execute. 

The Job Overview window appears.

17. Select the BI_PROCESS_ABAP job and click Job Log. 

The Job Log Entries window appears. It includes an entry about the status of the workflow that the 
process chain was configured to start.

Inserting a Data Transfer Process
Insert a Data Transfer Process (DTP) for the open hub destination that you created in SAP BW.

1. In the Process Chain Maintenance Planning View window, click Process Types. 

2. From the Process Types menu, click Load Process and Post-Processing > Data Transfer Process. 

The Insert Data Transfer Process dialog box appears.

3. In the Data Transfer Process field, click the Browse button to select the DTP that you created. 

4. Click Enter. 

The DTP appears in the Process Chain Maintenance Planning View window.

5. Link the ZPMSENDSTATUS ABAP program to the DTP. 

The process chain flow is set as follows: Start > ABAP Program (zpmsendstatus) > Data Transfer 
Process

6. Click Checking View and then click Activate. 

7. Click Execute and assign the process chain to a specific SAP BW server. 
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If you scheduled the process chain to run immediately, the process chain starts running on the assigned 
SAP BW server.

8. Optionally, to view the status of the process chain, click Job Overview. 

Inserting an InfoSpoke Process
Insert a process for the InfoSpoke you created in SAP BW.

1. In the Process Chain Maintenance Planning View window, click Process Types. 

2. From the Process Types menu, click Load Process and Post-Processing > Data Export Into External 
Systems. 

The Insert Data Export into External Systems dialog box appears.

3. In the Process Variants field, click the Browse button to select the InfoSpoke that you created. 

4. Click Enter. 

The InfoSpoke process appears in the Process Chain Maintenance Planning View window.

5. Link the ZPMSENDSTATUS ABAP program to the InfoSpoke process. 

The process chain flow is set as follows: Start > ABAP Program (zpmsendstatus) > InfoSpoke.

6. Click Checking View and then click Activate. 

7. Click Execute and assign the process chain to a specific SAP BW server. 

If you scheduled the process chain to run immediately, the process chain starts running on the assigned 
SAP BW server.

8. Optionally, to view the status of the process chain, click Job Overview. 

Configuring and Starting the Process Chain from Informatica
You can use the command line program to configure and start the process chain.

Use the following commands:

Operating 
System

Command Description

Linux infacmd.sh sap 
setOpenHubServiceParameters

Run this command to set the third-party parameters for the 
Open Hub Destination or InfoSpoke that is part of the process 
chain.

Linux infacmd.sh sap startProcessChain Run this command to start the process chain and optionally 
set the third-party parameters for the Open Hub Destination or 
InfoSpoke that is part of the process chain.

Windows infacmd.bat sap 
setOpenHubServiceParameters

Run this command to set the third-party parameters for the 
Open Hub Destination or InfoSpoke that is part of the process 
chain.

Windows infacmd.bat sap startProcessChain Run this command to start the process chain and optionally 
set the third-party parameters for the Open Hub Destination or 
InfoSpoke that is part of the process chain.

If you configure the third-party parameters with the ZPMSENDSTATUS ABAP program, you cannot configure 
the parameters with the infacmd.sh sap setOpenHubServiceParameters or infacmd.bat sap 
setOpenHubServiceParameters command. infacmd.sh sap startProcessChain or infacmd.bat sap 
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startProcessChain uses the parameters that are configured in the ZPMSENDSTATUS ABAP program to start 
the process chain.

If you configure the third-party parameters with the infacmd.sh sap setOpenHubServiceParameters or 
infacmd.bat sap setOpenHubServiceParameters command, you do not need to enter the parameters again 
when you run the infacmd.sh sap startProcessChain or infacmd.bat sap startProcessChaincommand.

Tip: To view help for infacmd.sh sap, enter infacmd.sh sap help setOpenHubServiceParameters or infacmd.sh 
sap help startProcessChain. 

To view help for infacmd.bat sap, enter infacmd.bat sap help setOpenHubServiceParameters or infacmd.bat 
sap help startProcessChain.

Before you run a command, use the pmpasswd command to encrypt the password to connect to the SAP 
system.

The setOpenHubServiceParameters command uses the following syntax:

setOpenHubServiceParameters 
<-UserName|-un> user_name
<-Password|-pd> password
<-SystemNumber|-sy> system_number
<-HostName|-hn> host_name
<-ClientNumber|-cl> ClientNumber
[<-Language|-lg> Language]
[<-Trace|-tr> Trace]
<-OpenHubDest|-od> OpenHubDest
<-ThirdPartyDest|-td> ThirdPartyDest
[<-ProcessChainName|-pc> ProcessChainName]
[<-FolderName|-fn> FolderName]
<-WorkflowName|-wn> WorkflowName
<-ProjectName|-pn> ProjectName
<-ApplicationName|-an> ApplicationName
[<-DataIntegrationServiceName|-is> DataIntegrationServiceName]
[<-DomainName|-dn> DomainName]
<-Context|-cn> Context

The startProcessChain command uses the following syntax:

startProcessChain
<-UserName|-un> user_name
<-Password|-pd> password
<-SystemNumber|-sy> system_number
<-HostName|-hn> host_name
<-ClientNumber|-cl> ClientNumber
[<-Language|-lg> Language]
[<-Trace|-tr> Trace]
[<-OpenHubDest|-od> OpenHubDest]
[<-ThirdPartyDest|-td> ThirdPartyDest]
<-ProcessChainName|-pc> ProcessChainName
[<-FolderName|-fn> FolderName]
[<-WorkflowName|-wn> WorkflowName]
[<-ProjectName|-pn> ProjectName]
[<-ApplicationName|-an> ApplicationName]
[<-DataIntegrationServiceName|-is> DataIntegrationServiceName]
[<-DomainName|-dn> DomainName]
[<-Context|-cn> Context]
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The following table describes the options and arguments for the infacmd.sh sap 
setOpenHubServiceParameters and infacmd.sh sap startProcessChain commands:

Options Argument Description

-UserName
-un

user_name Required.
User name for the SAP source system connection.

-Password
-pd

password Required.
Encrypted password. Run pmpasswd to encrypt the 
password.

-SystemNumber
-sy

system_number Required.
SAP system number.

-HostName
-hn

host_name Required.
SAP host name.

-ClientNumber
-cl

ClientNumber Required.
SAP client number.

-Language
-lg

Language Optional.
Language in which you want to receive messages 
from the SAP BW system. Use a language code that is 
valid for the SAP BW system that you are connecting 
to. If you leave this blank, the Developer tool uses the 
default language of the SAP system to connect to SAP 
BW.

-Trace
-tr

Trace Optional.
Tracks the JCo calls that the SAP system makes. SAP 
stores the information about the JCo calls in a trace 
file.

-OpenHubDest
-od

OpenHubDest Required for the setOpenHubServiceParameters 
command.
Optional for the startProcessChain command.
Open hub destination or InfoSpoke destination in the 
SAP system.

-ThirdPartyDest
-td

ThirdPartyDest Required for the setOpenHubServiceParameters 
command.
Optional for the startProcessChain command.
Third-party destination in the SAP system.

-ProcessChainName
-pc

ProcessChainName Required for the startProcessChain command.
Optional for the setOpenHubServiceParameters 
command.
Name of the process chain that you want to start.

-FolderName
-fn

FolderName Optional.
Name of the folder that contains the workflow that 
you want to run.
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Options Argument Description

-WorkflowName
-wn

WorkflowName Required for the setOpenHubServiceParameters 
command.
Optional for the startProcessChain command.
Name of the workflow that you want to run to extract 
data from SAP BW.

-ProjectName
-pn

ProjectName Required for the setOpenHubServiceParameters 
command.
Optional for the startProcessChain command.
Name of the project that contains the workflow that 
you want to run.

-ApplicationName
-an

ApplicationName Required for the setOpenHubServiceParameters 
command.
Optional for the startProcessChain command.
Name of the application that contains the workflow to 
extract data from SAP BW.

-DataIntegrationServiceName
-is

DataIntegrationServiceName Optional.
Name of the Data Integration Service that you created 
to run the workflow.

-DomainName
-dn

DomainName Optional.
Name of the Informatica domain.

-Context
-cn

Context Required for the setOpenHubServiceParameters 
command.
Optional for the startProcessChain command.
Set the value to BWOHS to read data from SAP BW 
through an Open Hub Destination or InfoSpoke.

Changing the Data Extraction Status
When an SAP BW OHS mapping fails, you must change the status of the failed mapping in SAP BW before 
you can start another workflow. Set the status of the failed request ID to G.

1. Go to transaction SE37. 

The Function Builder: Initial Screen appears.

2. In the Function Module field, enter RSB_API_OHS_REQUEST_SETSTATUS and click Test/Execute. 

The Test Function Module: Initial Screen appears.

3. Enter the import parameters and click Execute. 
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The following table describes the import parameters:

Import Parameter Description

Request ID Request ID of the failed session. You can identify the Request ID of the failed session from 
the workflow log or BW monitor.

Status G, which represents a successful data extraction session.

Message Description of the change you make.

BW OHS Data Extraction Status
You can view the status of data extraction from the Administrator tool and from the BW monitor in the SAP 
system.

Viewing Data Extraction Status from SAP
You can view the data extraction status from the SAP BW monitor in SAP BW. It shows green if the data 
extraction was successful and red if the data extraction failed.

The SAP BW monitor also shows the following information about the data extraction:

• Number of packets sent

• Number of rows in each packet

• Time taken for sending the packet

• Start time and end time

If the data extraction fails, you can start the InfoSpoke again to start the data extraction process. You can 
start the InfoSpoke again only after the Data Integration Service completes extracting data from the database 
table and sends the status to the SAP BW monitor.

Viewing Data Extraction Status from Informatica
When you extract data from SAP BW, you can view the SAP BW Service log events in the Administrator tool. 
On the Logs tab, you can enter search criteria to find the SAP BW Service log events.

The SAP BW Service captures log events that track interactions between Informatica and SAP BW. It captures 
its own log events. It also captures log events when it receives the following information from the SAP BW 
system and the Data Integration Service:

• A request from the SAP BW system to start an Informatica workflow.

• A message from the Data Integration Service that it has successfully started a workflow to extract data 
from SAP BW.

• A message from the Data Integration Service indicating whether the workflow failed or succeeded.

To view log events about how the Data Integration Service processes an SAP BW workflow, view the 
workflow log.
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Part IV: SAP BW Data Load
This part contains the following chapters:

• Introduction to SAP BW Data Load, 68

• Building SAP Objects for BW Data Load, 70

• Building Informatica Objects for BW Data Load, 80

• Loading Data to SAP BW, 86
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Introduction to SAP BW Data Load
This chapter includes the following topics:

• SAP BW Data Load Overview, 68

• SAP BW Data Load Process Flow, 68

SAP BW Data Load Overview
You can use PowerExchange for SAP NetWeaver to write data to SAP BW through a 3.x data source or 7.x 
data source. Based on the version of the SAP BW system that you want to write data to, you can create an 
InfoSource or DataSource.

To write data to SAP BW, you must complete configuration tasks on both the SAP and Informatica systems. 
You must trigger the data load from SAP.

SAP BW Data Load Process Flow
To write data to SAP BW, you must complete configuration tasks on both the SAP and Informatica systems.

1. In the SAP system, create an InfoSource or DataSource based on the version of the SAP BW system that 
you want to write data to.

2. Assign the InfoSource or DataSource to an external logical system, that is, the Informatica system.

3. Activate the InfoSource or DataSource.

4. In Informatica Developer, create an SAP connection and use the connection to import an SAP BW Load 
data object. You can create an SAP BW Load data object based on an InfoSource or DataSource.

5. Create a data object write operation based on the SAP BW Load data object.

6. Define the write operation properties to determine how the Data Integration Service must write data to 
SAP BW.

7. Create a mapping with the write operation as the target.

8. Create a workflow based on the mapping.

9. Create an application based on the workflow and deploy the application to the Data Integration Service.

10. Create and start an SAP BW Service.

11. Configure an InfoPackage in SAP to write data to the InfoSource or DataSource.
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12. Configure the Informatica system details under the third-party details in SAP. Enter the workflow name, 
application name, project name, and folder name. You can also use the command line utilities to define 
the third-party details in SAP.

13. Initiate the data load from SAP. You can either start the load immediately from SAP or schedule to run it 
a later time.

To schedule the data load, configure a process chain in SAP.

Note: When you write data to SAP BW version 7.3 by using 7.x DataSources, the InfoPackage loads the 
data to the PSA. To load the data from the PSA to an SAP target, you must create a Data Transfer 
Process (DTP), and configure a process chain that links the InfoPackage and DTP.
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Building SAP Objects for BW Data 
Load

This chapter includes the following topics:

• SAP Objects for BW Data Load Overview, 70

• InfoSources, 71

• DataSources, 71

• SAP BW Hierarchy, 71

• Transfer Methods for Writing Data to SAP BW, 73

• Creating an InfoSource or DataSource, 74

• Assigning an External Logical System, 79

• Activating the InfoSource or DataSource, 79

SAP Objects for BW Data Load Overview
To load data into SAP BW, you need to create components in the SAP BW system. The components that you 
need to create depend on the version of the SAP BW system that you want to write data to.

In SAP BW versions earlier than 7.3, you can create an InfoSource, assign it to the Informatica logical system 
that you created in SAP BW, and activate the InfoSource. When you create and activate the InfoSource, you 
specify the InfoSource type and the transfer method that the workflow uses to write data to the InfoSource.

In an SAP BW version 7.3 system, you can create a 7.x DataSource with the source system as the Informatica 
logical system that you created in SAP BW. You can activate the 7.x DataSource and use it to load data to the 
Persistent Storage Area (PSA).

In an SAP BW version 7.3 system, you can also create a 7.x InfoSource and associate it with a 7.x DataSource 
through transformations. You can then use the 7.x DataSource to load data to an InfoProvider.

Note: You can also load data into SAP BW version 3.5 or earlier.
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InfoSources
You can use an InfoSource to write data to the SAP BW system. An InfoSource is a collection of data in the 
SAP BW system that logically belongs together and is summarized into a single unit.

You can load data into two types of InfoSources:

InfoSource for transaction data

Use an InfoSource for transaction data to load data that changes often and is dependent on master data. 
For example, you can assign transaction data about sales development to a vendor’s master data and 
use the transaction data to determine the total sales of a vendor.

InfoSource for master data

Use an InfoSource for master data to load data that is frequently used and remains constant over a long 
period of time. For example, the master data of a vendor might contain the name, address, and bank 
account information for the vendor. Create an InfoSource for master data when you want to load data 
into an SAP BW hierarchy.

DataSources
DataSources contain a logical grouping of fields that describe the metadata of the source. Use DataSources 
to extract data from a source system and transfer the data to the BW system.

You can use a 7.x DataSource to load data to the PSA. Configure a Data Transfer Process (DTP) to load data 
to the PSA. To transfer the data from the PSA to an SAP target, configure a process chain that links the 
InfoPackage and DTP.

You can create the following types of 7.x DataSources:

• DataSource for transaction data

• DataSource for master data text

• DataSource for master data attributes

• DataSource for hierarchies

SAP BW Hierarchy
An SAP BW hierarchy is a tree-like structure that defines classes of information. Each level of the hierarchy 
represents a different class. A hierarchy displays an SAP BW characteristic, which is a reference object with 
dimensions.

The hierarchy is structured and grouped according to individual evaluation criteria based on the 
characteristic. The structure at each level of the hierarchy is called a node.

Node Types

A hierarchy has the following types of nodes:
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Root node

The root node is the highest node in the structure and is the origin of all other nodes. The root node 
represents the hierarchy.

Child node

A child node is a node that is subordinate to another node.

Leaf node

Leaf nodes are the lowest level in the hierarchy. Leaf nodes do not have any successor nodes.

You can create a workflow to load data into an SAP BW hierarchy. To load data into a hierarchy, create an 
InfoSource or DataSource for master data in the target SAP BW system. Then, import the hierarchy as a data 
object into the Developer tool. When you import the definition of a hierarchy, the Developer tool creates a 
transfer structure with fields that make up the structure of the SAP BW hierarchy.

Hierarchy Structure

You can configure the structure of a hierarchy in the InfoSource or DataSource properties. The following 
settings define the structure of an SAP BW hierarchy:

Sorted hierarchy

A sorted hierarchy defines the sequence of nodes for each level of a hierarchy. When you specify a 
sorted hierarchy, each child node is ordered in relation to its sibling nodes.

Interval hierarchy

An interval hierarchy specifies a range of characteristic values. You can use one interval to represent 
multiple leaf nodes. You define an interval in SAP BW by setting a range of values.

Time-dependent hierarchy

A time-dependent hierarchy specifies a range of dates. You can define either the entire hierarchy or the 
hierarchy structure as time dependent. When the entire hierarchy is time dependent, it is valid only in a 
defined range of dates. When the hierarchy structure is time dependent, the nodes in the hierarchy 
change for specified periods of time while the name and version of the hierarchy remain static. You 
define a date range in SAP BW by setting a range of dates.

Version-dependent hierarchy

Version-dependent hierarchies have the same name, but different versions.

When you import an InfoSource or DataSource with a hierarchy, the Developer tool creates only the fields in 
the transfer structure definition that are required to replicate the structure of the SAP BW hierarchy.

The following table shows the fields that the Developer tool can create in the data object when you import the 
metadata for a hierarchy definition from SAP BW:

Field Name Hierarchy Type Description

NODEID All hierarchies Local and unique identifier for the hierarchy node.

INFOOBJECT All hierarchies InfoObject that is referenced by the hierarchy node.

NODENAME All hierarchies Name of the hierarchy node.

LINK All hierarchies Specifies a field as a link node.

PARENTID All hierarchies NODEID of the parent node of the hierarchy node.
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Field Name Hierarchy Type Description

CHILDID Sorted hierarchy NODEID of the first child node of the hierarchy node.

NEXTID Sorted hierarchy NODEID of the sibling node following the hierarchy node.

DATEFROM Time-dependent hierarchy Start date in a range of dates.

DATETO Time-dependent hierarchy End date in a range of dates.

LEAFFROM Interval hierarchy Lower limit for an interval node.

LEAFTO Interval hierarchy Upper limit for an interval node.

LANGU All hierarchies Language.

TXTSH All hierarchies Short text.

TXTMD All hierarchies Medium text.

TXTLG All hierarchies Long text.

If you import different versions of a hierarchy into a data object, the hierarchy name includes the version. If 
you import a hierarchy with time-dependent values, the hierarchy name contains the date range specified for 
the hierarchy.

When you run a workflow, the Data Integration Service loads the hierarchy into the transfer structure fields.

Transfer Methods for Writing Data to SAP BW
In the SAP BW Administrator, you can specify the transfer method that you want to use to load data into SAP 
BW.

You can use the following transfer methods to load data into SAP BW:

• IDoc transfer method

• PSA transfer method

IDoc Transfer Method
Use the IDoc transfer method to synchronously move data from transfer structures to InfoCubes. When you 
use the IDoc transfer method, the Data Integration Service loads the data into a transfer structure for SAP 
BW. With the IDoc transfer method, you can process a data load while the InfoPackage runs.

PSA Transfer Method
Use the PSA transfer method when you want to load data into the Persistent Storage Area (PSA) before you 
write the data to an Operational Data Store (ODS) or InfoCube. When you use the PSA transfer method in SAP 
BW, the Data Integration Service loads the data to SAP BW. SAP BW stores the data in a PSA, and then 
updates or transforms the data.

Transfer Methods for Writing Data to SAP BW       73



When you use a 7.x DataSource to load data to SAP BW version 7.3, the transfer option is set to load data to 
the PSA because the InfoPackage loads data only to the PSA.

When you use 3.x data sources to load data to SAP BW, you can use one of the following PSA transfer 
options:

PSA and then into Data Targets

Select this option when you want to store data in the PSA before you load the data to data targets such 
as an ODS, InfoCube, or InfoSource.

PSA and Data Targets in Parallel

Select this option when you want to load data to the PSA and the data targets at the same time to 
achieve high performance.

Only PSA

Select this option when you want to load data only to the PSA. You can also select the Update 
Subsequently in Data Targets option to load the data to data targets after you load the data to the PSA.

Data Targets Only

Select this option when you want to load data only to data targets such as an ODS, InfoCube, or 
InfoSource.

For optimal performance, configure the transfer option to load data to the PSA. After the source system 
loads the PSA, you can update the InfoCubes in SAP BW.

Creating an InfoSource or DataSource
Create an InfoSource or DataSource based on the version of the SAP BW system that you want to write data 
to.

InfoSources are equivalent to target tables in the SAP BW operational data store. The logical system that you 
create for Informatica in SAP BW populates the InfoSource with data.

DataSources are equivalent to target tables in the PSA layer. DataSources define the metadata of the source 
system. Use a DataSource to transfer data to the SAP BW system.

Creating a 7.x InfoSource in SAP BW 7.3
While loading data to SAP BW 7.3, you can create a 7.x InfoSource when you want to connect multiple 7.x 
DataSources to a target and all the DataSources have the same business rules. You use the 7.x DataSources 
as the source when you create a transformation in SAP BW to load data to an InfoProvider.

1. In the Data Warehousing Workbench, click InfoSources. 

2. Right-click the InfoSources folder, and select Create application component. 

3. Enter the application component parameters and click Enter. 
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The following table describes the application component parameters:

Parameter Description

Application Comp Organizes logical systems.

Long Description Description of the application component.

The application component appears in the Data Warehousing Workbench.

4. Right-click the application component and select Create InfoSource. 

The Create InfoSource dialog box appears.

5. Enter the InfoSource parameters and click Enter. 

The following table describes the InfoSource parameters:

Parameter Description

InfoSource Name of the InfoSource.

Long description Description of the InfoSource.

Copy from Leave this section blank.

Creating an InfoSource
Use an InfoSource as a target when you create a transformation in SAP BW to load data to an InfoProvider.

1. In the Data Warehousing Workbench, click InfoSources. 

2. Right-click the InfoSources folder, and select Create application component. 

3. Enter the application component parameters and click Enter. 

The following table describes the application component parameters:

Parameter Description

Application Comp Organizes logical systems.

Long Description Description of the application component.

The application component appears in the Data Warehousing Workbench.

4. Right-click the application component and select Create InfoSource. 

5. In the Create InfoSource dialog box, select the InfoSource type. 

Select Direct update of Master Data to create an InfoSource with a hierarchy.

6. Click Enter. 

The InfoSource appears in the Data Warehousing Workbench.
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Creating a 3.x InfoSource
You can create a 3.x InfoSource when you want to use an InfoPackage and load data to the PSA. SAP BW 
creates a data source when you activate the 3.x InfoSource. You use the 3.x data source as the source when 
you create a transformation in SAP BW to load data to an InfoProvider or OHS.

1. In the Data Warehousing Workbench, click InfoSources. 

2. Right-click the InfoSources folder, and select Create application component. 

3. Enter the application component parameters and click Enter. 

The following table describes the application component parameters:

Parameter Description

Application Comp Organizes logical systems.

Long Description Description of the application component.

The application component appears in the Data Warehousing Workbench.

4. Right-click the application component and select Additional Functions > Create InfoSource 3.x. 

The Create InfoSource dialog box appears.

5. Select Flexible Update in Any Data Target (Except Hierarchies), enter the InfoSource parameter 
information, and click Enter. 

The following table describes the InfoSource parameters:

Parameter Description

InfoSource Name of the InfoSource.

Long description Description of the InfoSource.

Template-InfoSource Leave this option blank.

The InfoSource appears in the Data Warehousing Workbench.

Creating an InfoSource in SAP BW 3.5 or Earlier
1. In the Administrator Workbench, click InfoSources. 

2. Right-click the InfoSources folder, and select Create application component. 

3. Enter the following information and click Enter: 

The following table describes the application connection parameters:

Parameter Description

Application Comp Organizes logical systems.

Long Description Description of the application component.
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The application component appears in the Workbench.

4. Right-click the application component and select Create InfoSource. 

5. In the Create InfoSource dialog box, select the InfoSource type. 

Select Direct update of Master Data to create an InfoSource with a hierarchy.

6. Click Enter. 

The InfoSource appears in the Administrator Workbench.

Creating a 7.x DataSource in SAP BW 7.3
You can create a 7.x DataSource when you want to use an InfoPackage and load data to the PSA. You can 
then configure a DTP to transfer the data from the PSA to an SAP target.

1. Define Informatica as a logical system in the SAP BW 7.3 system. 

2. Create an SAP BW Service by using the Administrator tool and enable the service. 

3. In the Data Warehousing Workbench, click DataSources. 

4. Right-click the DataSources folder, and select Create application component. 

5. Enter the application connection parameters and click Enter: 

The following table describes the application connection parameters:

Parameter Description

Application Comp Organizes logical systems.

Long Description Description of the application component.

The application component appears in the Data Warehousing Workbench.

6. Right-click the application component and select Create DataSource. 

The Create DataSource dialog box appears.

7. Enter the DataSource parameters and click Enter. 

The following table describes the DataSource parameters:

Parameter Description

DataSource Name of the DataSource.

Source system Name of the source system that populates the DataSource with data.

Data Type DataSource Type of the DataSource that you want to create.
You can create the following types of DataSources:
- DataSource for transaction data
- DataSource for master data text
- DataSource for master data attributes
- DataSource for hierarchies

The DataSource appears in the Data Warehousing Workbench.
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8. Click the Fields tab and add InfoObjects to the DataSource. 

The InfoObjects you use in the DataSource display as ports in the data object.

9. Select the data format options for the InfoObjects. 

The following table describes the data format options:

Parameter Description

Internal Format Indicates if the data from the source is in a secure internal format.
When you select this option, SAP does not verify or convert the format. Therefore, if the 
source does not return data in an internal format, there could be data inconsistencies or errors 
in the loading process.

External Format Indicates if the data from the source is in an external format.
When you select this option, SAP converts the data into an internal format before it passes the 
data to the transformation.

Check for 
Internal Format

Indicates if the SAP system must verify whether the data from the source system is in an 
internal format.
Select this option if the data from the source is in an internal format, but it must be verified 
before being passed to the transformation. Select this option to ensure data conformity.

10. After creating metadata, click Enter to return to the Data Warehousing Workbench. 

Configuring Hierarchy Structure
After you create an InfoSource, you can include an InfoObject with a hierarchy in the InfoSource. After you 
associate the InfoObject containing a hierarchy with an InfoSource, you can configure the hierarchy structure 
in the InfoSource properties.

To create an InfoSource with a hierarchy in SAP BW, specify that the InfoObject you want to include in the 
InfoSource will be used in a hierarchy. On the Hierarchy tab of the InfoObject details window, ensure that you 
select the with hierarchies option. You assign this InfoObject to the InfoSource when you create the 
InfoSource. To configure and use an SAP BW hierarchy, create an InfoSource for master data.

After you create the InfoSource, select the InfoSource properties to configure the hierarchy structure.

1. Double-click the InfoSource. 

2. Select Transfer_Structure/Transfer_Rules. 

3. Enter values for the Source System and the DataSource options. 

Ensure that the value for the DataSource option is a hierarchy.

4. Click Hier. Structure to enter the name for the hierarchy. 

You can select additional properties to configure the structure of the hierarchy.

5. Save the InfoSource. 
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Assigning an External Logical System
After you create an InfoSource, you must associate it with the external logical system that you created for 
Informatica in SAP BW. You must also add metadata to the InfoSource.

1. Perform one of the following tasks based on the version of the SAP BW system that you want to write 
data to: 

• In the Data Warehousing Workbench for SAP BW 7.0, right-click the 3.x InfoSource and select Assign 
DataSource.

• In the Administrator Workbench for SAP BW 3.5 or Data Warehousing Workbench for SAP BW 7.0, 
right-click the InfoSource and select Assign DataSource.

2. Select the external logical system that you created for Informatica and click Enter. 

3. Add InfoObjects to the InfoSource. 

The InfoObjects that you use in the InfoSource display as ports in the data object.

4. After creating metadata, click Enter to return to the Administrator Workbench or Data Warehousing 
Workbench. 

Activating the InfoSource or DataSource
After you create an InfoSource or a DataSource and assign it to an external logical system, you must activate 
the InfoSource or DataSource to load data to SAP BW.

The InfoSource contains the metadata that is used as the basis for the transfer and communication 
structure. When you activate the InfoSource, you also maintain the transfer rules and communication 
structure. Transfer rules must be active for Informatica to load data into the transfer structure.

The Data Integration Service loads data to the PSA based on the DataSource. To activate a DataSource, 
select the DataSource and click the Activate button. When you activate the DataSource, SAP generates a PSA 
table in the entry layer of BW. You can then load the data into the PSA and create a DTP to load the data from 
the PSA to an SAP target.

1. In the Administrator Workbench for SAP BW 3.5 or Data Warehousing Workbench for SAP BW 7.0, right-
click the InfoSource and select Change. 

2. Select the InfoObjects and move them into the communication structure. 

3. Click the Activate button. 

4. Click the Transfer rules tab. 

5. Select the transfer method and click Activate: 

The following table describes the transfer methods:

Method Description

IDoc Use IDoc to synchronously move data from the transfer structure to an InfoCube.

PSA Required for SAP BW 7.0. Use PSA to load data into the PSA.

Note: If you want to populate an InfoCube in SAP BW 3.5, you must define it in the Administrator 
Workbench. Define the update rules to update the InfoCube from the transfer structure.
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C h a p t e r  1 3

Building Informatica Objects for 
BW Data Load

This chapter includes the following topics:

• Informatica Objects for BW Data Load Overview, 80

• Importing an SAP BW Load Data Object, 81

• SAP BW Load Data Object Properties, 82

• Creating an SAP BW Load Data Object Write Operation, 82

• SAP BW Load Data Object Write Operation Properties, 83

• Input Properties of an SAP BW Load Data Object Write Operation, 83

• Parameterization, 84

• Partitioning, 84

• SAP BW Load Mapping, Workflow, and Application Configuration, 85

Informatica Objects for BW Data Load Overview
To write data to SAP BW, you must create an SAP BW Load data object. An SAP BW Load data object is a 
physical data object that uses an SAP BW object as the target.

To create an SAP BW Load data object, import metadata from a 3.x data source or 7.x data source into the 
Developer tool. Create a data object write operation based on the data object. Then, configure the write 
operation properties to determine how the Data Integration Service must write data to SAP BW.

After you configure a write operation, you can create a mapping to write data to SAP BW. Add the write 
operation as a target in the mapping. You can then add a source and transformations in the mapping.

Create a workflow based on the mapping. Then, create an application based on the workflow and deploy the 
application to the Data Integration Service.

80



Importing an SAP BW Load Data Object
Import an SAP BW Load data object to specify the SAP BW object to which you want to write data. You can 
write data to 3.x data sources or 7.x data sources. You can then create a data object write operation based 
on the data object.

1. Select a project or folder in the Object Explorer view. 

2. Click File > New > Data Object. 

3. Select SAP BW Load Data Object and click Next. 

The New SAP BW Load Data Object dialog box appears.

4. Enter a name for the data object. 

5. Click Browse next to the Location option and select the target project or folder. 

6. Click Browse next to the Connection option and select the SAP connection from which you want to 
import the metadata of the 3.x data source or 7.x data source. 

7. To add a resource, click Add next to the Selected Resources option. 

The Add Resource dialog box appears.

8. On the left pane, expand the connection name. 

• To import a 3.x data source, expand the 3.x Datasources option on the left pane, and then expand the 
object type. Select the source system from which you want to import the data source. A list of 3.x 
data sources appear on the right pane. Select the data source that you want to import.

• To import a 7.x data source, expand the 7.x Datasources option on the left pane and select the object 
type. A list of 7.x data sources appear on the right pane. Select the data source that you want to 
import.
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9. Click OK. 

10. Click Finish. 

The data object appears under Physical Data Objects in the project or folder in the Object Explorer view.

SAP BW Load Data Object Properties
The Overview view of the SAP BW Load data object displays general information about the data object and 
the properties of the SAP BW resource that you import.

General Properties

You can configure the following general properties for an SAP BW Load data object:

• Name. Name of the SAP BW Load data object.

• Description. Description of the SAP BW Load data object.

• Connection. Name of the SAP connection. Click Browse to select a different SAP connection. You can 
also parameterize the connection.

Object Properties

You can configure the following general properties and column properties for the SAP BW resource that 
you add in the data object:

• Name. Business name of the SAP BW resource.

• Description. Description of the SAP BW resource.

• Native Name. Name of the SAP BW resource. You can also parameterize the native name.

• Path Information. Path to the SAP BW resource.

• Column Properties. Name, native name, data type, precision, scale, and description of the columns in 
the SAP BW resource.

Creating an SAP BW Load Data Object Write 
Operation

Create an SAP BW Load data object write operation from an SAP BW Load data object. You can then add the 
write operation as a target in a mapping.

1. Select the SAP BW Load data object in the Object Explorer view. 

2. Right-click the data object and select New > Data Object Operation. 

The Data Object Operation dialog box appears.

3. Enter a name for the data object write operation. 

4. Click Add. 

The Select Resources dialog box appears displaying the data object.

5. Select the data object and click OK. 
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6. Click Finish. 

The Developer tool creates the write operation for the selected SAP BW Load data object.

SAP BW Load Data Object Write Operation Properties
The Data Integration Service writes data to the SAP BW resource based on the data object write operation 
properties that you specify.

When you create a data object write operation, the Developer tool creates a Target transformation and an 
Input transformation. The Target transformation is named after the SAP BW resource and represents the 
data that the Data Integration Service writes to the resource. Select the Target transformation to view data 
such as the name and description of the SAP BW resource.

The Input transformation represents the data that the Data Integration Service passes into the mapping 
pipeline. Select the Input transformation to edit the ports, run-time, and advanced properties.

Input Properties of an SAP BW Load Data Object 
Write Operation

The Input transformation defines the run-time properties that the Data Integration Service uses to write data 
to the SAP BW resource.

You can configure the Input transformation to perform the following tasks:

• Edit the port properties.

• Change or parameterize the SAP connection.

• Configure partitioning.

• Define the advanced properties that the Data Integration Service must use to write data.

Ports Properties
The ports properties list the name, data type, precision, scale, and description for all the ports that the data 
object write operation contains.

You can configure the following ports properties in the data object write operation:

Property Description

Name Name of the port.

Type Data type of the port.

Precision Maximum number of digits for numeric data types or maximum number of characters for string data 
types. The precision includes the scale for numeric data types.
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Property Description

Scale Maximum number of digits after the decimal point for numeric values.

Description Description of the port.

Run-Time Properties
The run-time properties display the name of the connection that the Data Integration Service uses to write 
data to the SAP BW resource. You can select a different connection or parameterize the connection.

You can also use the Run-time tab to configure partitioning. You can configure dynamic partitioning.

Advanced Properties
In the advanced properties, you can configure the packet size that the Data Integration Service must use 
when it writes data to the SAP BW resource. The packet size defines the number of rows per packet.

When the Data Integration Service writes data, it stores data in memory until the bytes buffer size equals the 
value of the packet size. The Data Integration Service then writes the data to SAP BW as a packet.

Parameterization
You can parameterize the SAP connection and the packet size for the SAP BW Load data object to override 
the mapping properties at run time.

Partitioning
When you write data to SAP BW, you can configure dynamic partitioning to optimize the mapping 
performance.

When you configure dynamic partitioning, the Data Integration Service determines the number of partitions 
that it must create at run time. It scales the number of partitions based on factors such as the maximum 
parallelism value defined for the Data Integration Service and the mapping, and the number of CPUs available 
on the nodes where the mappings run.

For more information about configuring the maximum parallelism value, see the Informatica Application 
Services Guide and the Informatica Developer Mapping Guide.
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SAP BW Load Mapping, Workflow, and Application 
Configuration

After you create a mapping with an SAP BW Load data object, you must create a workflow. Then, create an 
application and deploy the workflow as an application to the Data Integration Service.

You must then enter initiate the data load from SAP. To initiate the data load, open the InfoPackage in the 
SAP system, and enter the following details under the 3rd Party Selections tab:

• Workflow name

• Application name

• Folder name
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C h a p t e r  1 4

Loading Data to SAP BW
This chapter includes the following topics:

• SAP BW Data Load Overview, 86

• Configuring an InfoPackage, 86

• Configuring a Data Transfer Process, 87

• Configuring a Process Chain to Load Data, 88

• BW Data Load Status, 91

SAP BW Data Load Overview
After you complete configuration tasks in the SAP BW and Informatica systems, you must initiate the data 
load from SAP BW. You can either start the data load immediately or schedule to run it at a later time.

You can view the data load status from both SAP and Informatica.

Configuring an InfoPackage
An InfoPackage is the SAP BW mechanism for scheduling and running ETL jobs. The InfoPackage defines the 
source system, and the target InfoSource or DataSource. You can also enter a data selection entry in the 
InfoPackage to select data from the source system.

Creating and Scheduling an InfoPackage
Create and schedule an InfoPackage in SAP BW 7.0 and 7.3 with the Data Warehousing Workbench. Create 
and schedule an InfoPackage in SAP BW 3.5 or earlier with the Administrator Workbench.

1. In the Administrator Workbench or Data Warehousing Workbench, click the InfoSources or DataSources 
tab. 

2. Locate the InfoSource or DataSource. 

3. Perform one of the following tasks based on whether you use an InfoSource or a DataSource: 

• Under the InfoSource, right-click the source system.

• Right-click the DataSource.

4. Select Create InfoPackage and enter a description for the InfoPackage. 
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5. Click Save. 

The Scheduler (Maintain InfoPackage) window appears.

6. Click the 3rd Party Selections tab. 

7. Click Refresh. 

8. Enter the domain, service, and workflow details. 

The following table describes the domain, service, and workflow details:

Property Description

Domain Name for DI Service Name of the Informatica domain for the Data Integration Service that runs 
the workflow.

Data Integration Service Name Name of the Data Integration Service that runs the workflow.

Name of Folder Containing 
Workflow

Name of the folder that contains the workflow.

Workflow Name Name of the workflow that you created to write data to SAP BW.

9. In the Processing tab, select a data transfer option. 

Note: For 7.x DataSources, the Only PSA data transfer option is selected by default because the 
InfoPackage loads the data only to the PSA.

10. Schedule the InfoPackage. Perform one of the following steps based on the version of the BW system to 
which you want to load data: 

• In SAP BW 3.5 or earlier, click the Scheduling Info tab.

• In SAP BW 7.0 and 7.3, click the Schedule tab. In SAP BW 7.0, click Start to run the InfoPackage 
immediately. In SAP BW 7.3, click Start Data Load Immediately. In SAP 7.0 and 7.3, you can also click 
Jobs to schedule the InfoPackage to run at a specific time.

Configuring a Data Transfer Process
When you use 7.x DataSources, the InfoPackage loads data to the PSA. To load the data from the PSA to an 
SAP target, you must configure a Data Transfer Process (DTP).

1. In the Administrator Workbench or Data Warehousing Workbench, click the DataSources tab. 

2. Locate the 7.x DataSource that you used to load the data in the PSA. 

3. Right-click the 7.x DataSource and select Create Data Transfer Process. 

The Create Data Transfer Process dialog box appears. The source of the DTP is set to the 7.x 
DataSource that you used for loading the data in the PSA.

4. Define the target of the DTP. Select the object type and enter the name of the SAP target to which you 
want to load the data from the PSA. 
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5. Save and activate the DTP. The SAP system generates a default transformation between the source and 
target of the DTP. 

Note: You can also right-click the SAP target to which you want to load the data and then create a DTP. 
The target of the DTP is set to the target that you selected for loading the data. You must then define the 
source of the DTP as the 7.x DataSource that you used to load the data in the PSA.

Configuring a Process Chain to Load Data
To load data into SAP BW, configure a process chain that links the following components:

• InfoPackage process

• Data Transfer Process

• Additional loading processes

• ZPMSENDSTATUS ABAP program

Note: You need to insert a Data Transfer Process in the process chain only when you load to SAP BW version 
7.3 by using 7.x DataSources.

The InfoPackage and loading processes process the data. The ABAP program sends status messages to the 
SAP BW Service. The SAP BW Service sends these messages to the Log Manager.

After inserting the ABAP program into the process chain, create a variant for the program. A variant is an SAP 
BW structure that contains parameter values that SAP BW passes during program execution.

When you load data to SAP BW 7.3 by using a 7.x DataSource, the transfer option is configured to load data 
to the PSA because the InfoPackage loads data only to the PSA.

When you load data by using 3.x data sources, use one of the following PSA transfer options:

PSA and then into Data Targets

Select this option when you want to store data in the PSA before you load the data to data targets such 
as an ODS, InfoCube, or InfoSource.

PSA and Data Targets in Parallel

Select this option when you want to load data to the PSA and data targets at the same time to achieve 
high performance.

Only PSA

Select this option when you want to load data only to the PSA. You can also select the Update 
Subsequently in Data Targets option to load the data to data targets after you load the data to the PSA.

Data Targets Only

Select this option when you want to load data only to data targets such as ODS, InfoCube, or InfoSource.

For optimal performance, configure the transfer option to load data to the PSA. After the source system 
loads the PSA, you can update the InfoCubes in SAP BW.

The process chain might contain a single InfoPackage that loads data to the PSA only or to a data target 
only. Insert the ZPMSENDSTATUS ABAP program after the InfoPackage to send the status to the SAP BW 
Service.

The process chain can also contain an InfoPackage that loads data to the PSA and additional processes that 
load the data to data targets. Insert the ZPMSENDSTATUS ABAP program after each loading process to 
ensure that the SAP BW Service receives status information at each point in the process chain.
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To configure a process chain and load data into SAP BW, perform the following steps:

1. Create the process chain and insert the start process.

2. Insert an InfoPackage process.

Note: When you insert an InfoPackage process for a 7.x DataSource, the DTP associated with the 7.x 
DataSource is also inserted.

3. Insert the ZPMSENDSTATUS ABAP program.

Creating the Process Chain and Inserting the Start Process
When you create the process chain and insert the start process, you also schedule the process chain.

1. From the Administrator Workbench or Data Warehousing Workbench, click SAP Menu > Administration > 
RSPC - Process Chains. 

The Process Chain Maintenance Planning View window appears.

2. Click Create. 

The New Process Chain dialog box appears.

3. Enter a unique name for the process chain and enter a description. 

4. Click Enter. 

The Insert Start Process dialog box appears.

5. Click Create. 

The Start Process dialog box appears.

6. Enter a unique name for the start process variant and enter a description. 

7. Click Enter. 

The Maintain Start Process window appears.

8. Click Change Selections to schedule the process chain. 

The Start Time window appears.

9. To schedule the process chain to run immediately after you execute it, click Immediate. 

10. Click Save. 

11. In the Maintain Start Process window, click Cancel. 

12. In the Insert Start Process dialog box, click Enter. 

The start process appears in the Process Chain Maintenance Planning View window.

Inserting an InfoPackage Process
Insert a process for the InfoPackage that you created in SAP BW.

1. In the Process Chain Maintenance Planning View window, click Process Types. 

2. From the Process Types menu, click Load Process and Post-Processing > Execute InfoPackage. 

The Insert Execute InfoPackage dialog box appears.

3. In the Process Variants field, click the Browse button to select the InfoPackage that you created. 

4. Click Enter. 

The InfoPackage process appears in the Process Chain Maintenance Planning View window.

Note: When you insert an InfoPackage process for a 7.x DataSource, the DTP associated with the 7.x 
DataSource is also inserted.
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5. Click the start process description and drag it to link the start process to the InfoPackage process. 

Inserting the ZPMSENDSTATUS ABAP Program
Before you insert the ZPMSENDSTATUS ABAP program into a process chain, you must import the program 
into SAP BW.

1. In the Process Chain Maintenance Planning View window, click Process Types. 

2. From the Process Types menu, click General Services > ABAP Program. 

The Insert ABAP Program dialog box appears.

3. Click Create. 

The ABAP Program dialog box appears.

4. Enter a unique name for the ABAP program process variant and enter a description. 

5. Click Enter. 

The Process Maintenance: ABAP Program window appears.

6. In the Program Name field, click the Browse button to select the ZPMSENDSTATUS ABAP program. 

7. Click Change next to the Program Variant field. 

The ABAP: Variants - Initial Screen window appears.

8. Click Create. 

9. In the ABAP: Variants dialog box, enter a name for the ABAP variant and click Create. 

The Maintain Variant window appears.

10. In the DEST field, select the name of the RFC destination. 

11. In the INFPARAM field, enter one of the following options: 

• PSA. Enter this option if the previous process loaded to the PSA.

• Data Target. Enter this option if the previous process loaded to a data target.

12. In the CONTEXT field, enter BW LOAD. 

13. In the INFOPAK field, enter the technical name of the InfoPackage. 

For example, ZPAK_439OS93K56GKQT7HQT5TFV1Z6.

14. Click Save and Exit in the Maintain Variant window. 

15. Click Save and Exit in the ABAP Variants window. 

16. Click Save and Exit in the Process Maintenance: ABAP Program window. 

17. Click Enter in the Insert ABAP Program dialog box. 

The ABAP program appears in the Process Chain Maintenance Planning View window.

18. Click the InfoPackage process description and drag it to link the InfoPackage process to the ABAP 
program. 

When prompted, click Successful condition.

Note: When you use a 7.x DataSource to load to the PSA, you must link the InfoPackage process to the 
Data Transfer Process and then link the Data Transfer Process to the ABAP program.

19. Optionally, insert additional loading processes into the process chain. 

20. Insert the ZPMSENDSTATUS program after each loading process. 

21. In the Process Chain Maintenance Planning View window, click Checking View and then click Activate. 

22. Click Execute and assign the process chain to a specific SAP BW server. 
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If you scheduled the process chain to run immediately, the process chain starts running on the assigned 
SAP BW server.

23. Optionally, to view the status of the process chain, click Job Overview. 

The Simple Job Selection window appears.

24. Enter selection criteria to specify the process chains that you want to monitor and click Execute. 

The Job Overview window appears.

25. Select the BI_PROCESS_ABAP job and click Job Log. 

The Job Log Entries window appears. It includes an entry about the status of the workflow that the 
process chain was configured to start.

BW Data Load Status
You can view the status of the data load from the Administrator tool and from the BW monitor in the SAP 
system.

The SAP BW Service captures log events that track interactions between Informatica and SAP BW. It also 
captures log events when it receives the following information from the SAP BW system and the Data 
Integration Service:

• A request from the SAP BW system to start a workflow.

• A message from the Data Integration Service that it has successfully started a workflow to load data into 
SAP BW.

• A message from the Data Integration Service indicating whether the workflow failed or succeeded.

• Status information from the ZPMSENDSTATUS ABAP program in the process chain that loads data to SAP 
BW.

When you load data into SAP BW, you can view the SAP BW Service log events in the following locations:

• Administrator tool. On the Logs tab, enter search criteria to find the SAP BW Service log events.

• SAP BW Monitor. In the Monitor - Administrator Workbench window, you can view the log events that the 
SAP BW Service captures for an InfoPackage included in a process chain that loads data into SAP BW.

To view log events about how the Data Integration Service processes an SAP BW workflow, view the 
workflow log.

Set the environment variable PMTOOL_DATEFORMAT to customize the date format that the SAP BW Service 
returns for log events. When you set the environment variable, the SAP BW Service validates the string before 
it writes a date to the log. If the date is not valid, the SAP BW Service uses the following default date display :

DY MON DD HH24:MI:SS YYYY

Viewing SAP BW Service Log Events in the SAP BW Monitor
You can use the SAP BW Monitor to view log events that the SAP BW Service captures for an InfoPackage 
included in a process chain that loads data into SAP BW. SAP BW pulls the messages from the SAP BW 
Service and displays them in the monitor. To view the messages, ensure that the SAP BW Service is running.

1. From the Administrator Workbench or Data Warehousing Workbench, click Monitor. 

The Monitor - Administrator Workbench window appears.
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2. Select an InfoPackage. 

3. Click Goto > Logs > Non-SAP System Extraction Log. 

The Third Party System Log dialog box appears displaying the log events that the SAP BW Service 
captured for the InfoPackage.

Viewing InfoPackage Status
The SAP BW Monitor displays the InfoPackage status. The status in the SAP BW monitor is green, yellow, or 
red depending on the status of the workflow . Green indicates that the data loaded successfully. Yellow 
indicates that the data loaded with warnings. Red indicates that the data failed to load.

The SAP BW Monitor indicates status in the following cases:

• The Data Integration Service did not load any rows to SAP BW because the source system did not contain 
any data. However, the workflow completed successfully. The SAP BW Monitor indicates a status of 
green, yellow, or red, depending on the Traffic Light Color for Empty Requests settings in the 
InfoPackage. Default is yellow.

• The Data Integration Service failed and did not load any row to SAP BW. The SAP BW Monitor indicates a 
status of red.

• The Data Integration Service failed after loading some data into SAP BW. The SAP BW Monitor indicates a 
status of red.

• If a workflow enabled for recovery fails, the SAP BW Monitor indicates a status of yellow. The status 
changes to green after the data loads successfully during the recovery run.
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Part V: SAP Pushdown 
Optimization

This part contains the following chapter:

• SAP Pushdown Optimization, 94
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SAP Pushdown Optimization
This chapter includes the following topics:

• SAP Pushdown Optimization Overview, 94

• Pushdown Optimization Expressions, 94

• SAP Data Type Exceptions, 95

SAP Pushdown Optimization Overview
When the Data Integration Service applies filter pushdown optimization, it pushes the Filter transformation 
logic to the SAP source. The amount of Filter transformation logic that the Data Integration Service can push 
to the source depends on the location of the Filter transformation in the mapping, the source type, and the 
Filter transformation logic.

The Data Integration Service translates the transformation expression into a query by determining equivalent 
operators and functions in the application. If there is no equivalent operator or function, the Data Integration 
Service processes the transformation logic.

Pushdown Optimization Expressions
The Data Integration Service can push Filter transformation logic to SAP sources for expressions that contain 
a column name, an operator, and a literal string. When the Data Integration Service pushes transformation 
logic to SAP, it converts the literal string in the expressions to an SAP data type.

Filter transformation expressions can include multiple conditions separated by AND or OR. If the conditions 
apply to multiple SAP tables and the SAP data object uses the Open SQL ABAP join syntax, the Data 
Integration Service can push transformation logic to SAP. Configure the Select syntax mode in the read 
operation of the SAP data object.

Pushdown Optimization Functions
The Data Integration Service can push down transformation logic that contains the TO_DATE function when 
TO_DATE converts a DATS, TIMS, or ACCP data type character string to one of the following date formats:

• MM/DD/YYYY

• YYYY/MM/DD
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• YYYY-MM-DD HH24:MI:SS

• YYYY/MM/DD HH24:MI:SS

• MM/DD/YYYY HH24:MI:SS

The Data Integration Service processes the transformation logic if you apply the TO_DATE function to a data 
type other than DATS, TIMS, or ACCP or if TO_DATE converts a character string to a format that the Data 
Integration Services cannot push to SAP.

The Data Integration Service processes transformation logic that contains other Informatica functions.

Pushdown Optimization Operators
The Data Integration Service can push down the following operators to SAP:

< > => = <= <> !=  ^=  AND OR

SAP Data Type Exceptions
The Data Integration Service processes the Filter transformation logic when the source cannot process the 
transformation logic and the transformation expression includes the following data types:

• RAW

• LRAW

• LCHR
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Data Type Reference
This appendix includes the following topics:

• SAP Data Types, 96

• PowerExchange for SAP NetWeaver and SAP Data Types, 97

• Unsupported SAP Data Types, 99

SAP Data Types
The following table lists the data types that are available in the SAP NetWeaver and SAP BW systems:

SAP Data 
Type

Type Range and Description

ACCP Date Posting period of 6 positions, the format is YYYYMM. In input and output, a point is inserted 
between year and month, so the template of this data type has the form ‘____.__’.

CHAR Text Character string with maximum length of 255. If longer fields are required, use LCHR.

CLNT Text Client fields.
Always has 3 positions.

CUKY Text Currency key of 5 positions containing the possible currencies referenced by CURR fields.

CURR Numeric Currency field with a maximum length of 31 positions. Equivalent to a DEC amount field. A 
CURR field must reference a CUKY field.
For P type, only 14 digits are allowed after the decimal point.

DATS Date 8-position date field. The format is YYYYMMDD.

DEC Numeric Maximum length of 31 positions. Counter or amount field with a decimal point, sign, and 
commas separating thousands.
For P type, only 14 digits are allowed after the decimal point.

FLTP Numeric Floating point number of 16 positions including decimal places.

INT1 Numeric 1-byte integer between 0 and 255.
3 positions.
Not supported for PowerExchange for SAP NetWeaver BW
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SAP Data 
Type

Type Range and Description

INT2 Numeric 2-byte integer between -32,767 to 32,767, only used for length fields; positioned immediately 
in front of LCHR and LRAW. With INSERT or UPDATE on the long field, the database interface 
enters the length used in the length field and the length is set at 5 positions.

INT4 Numeric 4-byte integer between -2,147,483,647 and 2,147,483,647. The length is set at 10 positions.

LANG Text Language key, field format for special functions of 1 position.

LCHR Text Long character string with a minimum length of 256 characters. Must be at the end of 
transparent table and must be preceded by a length field INT2.

LRAW Binary Limited support.
Long byte string with a minimum of 256 positions. Must be at the end of transparent table 
and must be preceded by a length field of type INT2.

NUMC Text Long character field of arbitrary length with a maximum length of 255 positions. You can 
enter only numbers.

QUAN Text Quantity field with a maximum length of 31 positions. Points to a unit field with the UNIT 
format.
For P type, only 14 digits are allowed after the decimal point.

RAW Binary Uninterrupted sequence of bytes with a maximum length of 255 positions. If longer fields are 
required, use LRAW.

TIMS Date Time field (HHMMSS) of 6 positions, the display format is HH.MM.SS.

UNIT Text Units key of 2 or 3 positions, field containing the allowed quantity units referenced by QUAN 
fields.

PowerExchange for SAP NetWeaver and SAP Data 
Types

PowerExchange for SAP NetWeaver uses the following data types in mappings:

• Native data types. Native data types are data types specific to the source and target databases or flat 
files. They appear in non-SAP ECC source definitions and target definitions in the mapping.

• SAP data types. SAP data types appear in the SAP definitions in the mapping. SAP performs any 
necessary conversion between the SAP data types and the native data types of the underlying source 
database tables.

• Transformation data types. Transformation data types are generic data types that Data Integration 
Service uses during the transformation process. They appear in all the transformations in the mapping.

The Data Integration Service converts SAP data types to transformation data types. The Data Integration 
Service passes all transformation data types to the target, and the target converts them to the native data 
types.
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The following table compares SAP data types and the transformation data types:

SAP Data 
Type

Transformation Data 
Type

Range for Transformation Data Type

ACCP Date/time Jan 1, 0001 A.D. to Dec 31, 9999 A.D.

CHAR String 1 to 104,857,600 characters
Fixed-length or varying-length string.

CLNT String 1 to 104,857,600 characters
Fixed-length or varying-length string.

CUKY String 1 to 104,857,600 characters
Fixed-length or varying-length string.

CURR Decimal Precision 1 to 28 digits, scale 0 to 28

DATS Date/time Jan 1, 0001 A.D. to Dec 31, 9999 A.D. Precision to the nanosecond.

DEC Decimal Precision 1 to 28 digits, scale 0 to 28

FLTP Double Precision 15, scale 0

INT1 Small Integer Precision 5, scale 0

INT2 Small Integer Precision 5, scale 0

INT4 Integer Precision 10, scale 0

LANG String 1 to 104,857,600 characters
Fixed-length or varying-length string.

LCHR String 1 to 104,857,600 characters
Fixed-length or varying-length string.

LRAW Binary Limited support in PowerExchange for SAP NetWeaver

NUMC Decimal or Double Precision 1 to 28 digits, scale 0 to 28

QUAN Decimal Precision 1 to 28 digits, scale 0 to 28

RAW Binary Uninterrupted sequence of bytes with a maximum length of 255 
positions.

TIMS Date/time Jan 1, 0001 A.D. to Dec 31, 9999 A.D. Precision to the nanosecond.

UNIT String 1 to 104,857,600 characters
Fixed-length or varying-length string.
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Unsupported SAP Data Types
PowerExchange for SAP NetWeaver does not support the following data types:

• PREC

• RAWSTRING

• SSTR

• STRG

• VARC

Unsupported SAP Data Types        99



I n d e x

A
ABAP mappings 

creating a package 20
Administrator tool 

SAP BW Service, configuring 28
authority checks 

creating users in SAP 19

B
BW data load 

creating a write operation 82
importing a data object 81

BW Load data object 
properties 82

BW Load write operation 
ports properties 83

BW OHS data extraction 
creating a read operation 55
importing a data object 54

BW OHS extract data object 
properties 55

BW OHS read operation 
advanced properties 57
description 56
output transformation 56
ports properties 56
run-time properties 57

C
child nodes 

SAP BW 71
cofiles 

description for SAP 17

D
data extraction 

scheduling for SAP BW 60
data transfer process 

configuring 87
data types 

PowerExchange for SAP NetWeaver 97
SAP 96
SAP BW 96
SAP native data types 97

datafiles 
description for SAP 17

DataSources 
activating 79
assigning logical system 79

DataSources (continued)
SAP BW, loading 71

development system 
installing and configuring 15

development user 
creating profiles for SAP 19

E
expressions 

SAP pushdown optimization 94

F
FTP 

accessing SAP stage files 37

H
hierarchies 

SAP BW 71
SAP BW child nodes 71
SAP BW leaf nodes 71
SAP BW root nodes 71
SAP BW structure types 71
structures for SAP BW, configuring 78

I
IDoc transfer method 

loading to SAP BW 73
InfoSources 

activating 79
assigning logical system 79
SAP BW, loading 71

interval hierarchies 
SAP BW 71

L
leaf nodes 

SAP BW 71
logical system 

assigning to DataSources 79
assigning to InfoSources 79

N
NFS Mount 

accessing SAP stage files 36

100



nodes 
SAP BW child nodes 71
SAP BW leaf nodes 71
SAP BW root nodes 71

P
package 

$TMP 20
creating 20
ZERP 17

production system 
installing and configuring 15

production user 
creating profiles for SAP 19

profiles 
creating for mySAP 19

PSA transfer method 
loading to SAP BW 73

pushdown optimization 
SAP source 94

R
root nodes 

SAP BW 71

S
SAP BW hierarchies 

structures, configuring 78
SAP BW Monitor 

log events 91
SAP BW Service 

creating through the Administrator tool 28
creating through the infacmd 25
disabling 28
editing 29
enabling 28
overview 24
properties 25

SAP connections 
properties 30

SAP pushdown optimization 
expressions 94

SAP Table data objects 
importing 39

security 
mySAP authorizations 19

SFTP 
accessing SAP stage files 37

sorted hierarchies 
SAP BW 71

stage files 
accessing SAP files with FTP 37
accessing SAP files with NFS mount 36
accessing SAP files with SFTP 37

T
test system 

installing and configuring 15
time-dependent hierarchies 

SAP BW 71
tp import 

development objects, transporting 17
transfer methods 

loading into SAP BW 73
transfer rules 

setting for SAP BW 79
transport programs 

running 18
YPMPARSQ 18

transports 
SAP, deleting 15
SAP, installing 17
SAP, upgrading 15

V
version-dependent hierarchies 

SAP BW 71

Y
YPMPARSQ 

description 18

Z
ZERP package 

description 17
ZPMSENDSTATUS 

creating a variant for SAP BW 60

Index        101


	Table of Contents
	Preface 
	Informatica Resources
	Informatica Network
	Informatica Knowledge Base
	Informatica Documentation
	Informatica Product Availability Matrixes
	Informatica Velocity
	Informatica Marketplace
	Informatica Global Customer Support


	Part I: Getting Started with PowerExchange for SAP NetWeaver
	Chapter 1: Introduction to PowerExchange for SAP NetWeaver
	PowerExchange for SAP NetWeaver Overview
	Introduction to SAP NetWeaver

	Chapter 2: PowerExchange for SAP NetWeaver Configuration
	PowerExchange for SAP NetWeaver Configuration Overview
	Prerequisites
	SAP Java Connector 3.0
	Transports Installation and Configuration
	Step 1. Delete Transport Programs
	Step 2. Install Transport Objects
	Step 3. Run Transport Programs
	Step 4. Create Users
	Step 5. Create Profiles
	Step 6. Create a Package
	Informatica Developer Transports

	Installing the zpmsetparameters.ab4 Program in the SAP BW System
	PowerExchange for SAP NetWeaver Uninstallation
	Cleaning Up the SAP System


	Chapter 3: SAP BW Service Configuration
	SAP BW Service Overview
	SAP BW Service Properties
	infacmd SAP BW Service Properties
	SAP BW Service Options

	Creating the SAP BW Service
	Enabling and Disabling the SAP BW Service
	Enabling the SAP BW Service
	Disabling the SAP BW Service

	Editing the SAP BW Service Properties
	Viewing Log Events

	Chapter 4: SAP Connection
	SAP Connection Overview
	SAP Connection Properties
	Creating an SAP Connection


	Part II: SAP Table Data Extraction
	Chapter 5: Introduction to SAP Table Data Extraction
	SAP Table Data Extraction Overview
	Staging Mode
	Stage File Reuse
	Modes of Access
	NFS Mount
	FTP or SFTP

	Streaming Mode
	Compressed Data Transfer

	Chapter 6: Building Informatica Objects for SAP Table Data Extraction
	Informatica Objects for SAP Table Data Extraction Overview
	Importing an SAP Table Data Object
	SAP Table Data Object Properties
	Creating an SAP Table Data Object Read Operation
	SAP Table Data Object Read Operation Properties
	Output Properties of an SAP Table Data Object Read Operation
	Ports Properties
	Query Properties
	Run-time Properties
	Advanced Properties

	SAP Table Data Extraction Mapping
	Parameterization
	Partitioning


	Part III: SAP BW OHS Data Extraction
	Chapter 7: Introduction to SAP BW OHS Data Extraction
	SAP BW OHS Data Extraction Overview
	SAP BW OHS Data Extraction Process Flow
	Raw Data Transfer

	Chapter 8: Building SAP Objects for BW OHS Data Extraction
	SAP Objects for BW OHS Data Extraction Overview
	Creating an Open Hub Destination
	Creating a Transformation
	Creating a Data Transfer Process

	Chapter 9: Building Informatica Objects for BW OHS Data Extraction
	Informatica Objects for BW OHS Data Extraction Overview
	Importing an SAP BW OHS Extract Data Object
	SAP BW OHS Extract Data Object Properties
	Creating an SAP BW OHS Extract Data Object Read Operation
	SAP BW OHS Extract Data Object Read Operation Properties
	Output Properties of an SAP BW OHS Extract Data Object Read Operation
	Ports Properties
	Run-time Properties
	Advanced Properties

	Parameterization
	Partitioning
	SAP BW OHS Mapping, Workflow, and Application Configuration

	Chapter 10: Extracting Data from SAP BW OHS
	Data Extraction from SAP BW OHS Overview
	Configuring and Starting a Process Chain from SAP BW
	Creating the Process Chain and Inserting the Start Process
	Inserting the ZPMSENDSTATUS ABAP Program
	Inserting a Data Transfer Process
	Inserting an InfoSpoke Process
	Configuring and Starting the Process Chain from Informatica
	Changing the Data Extraction Status

	BW OHS Data Extraction Status
	Viewing Data Extraction Status from SAP
	Viewing Data Extraction Status from Informatica



	Part IV: SAP BW Data Load
	Chapter 11: Introduction to SAP BW Data Load
	SAP BW Data Load Overview
	SAP BW Data Load Process Flow

	Chapter 12: Building SAP Objects for BW Data Load
	SAP Objects for BW Data Load Overview
	InfoSources
	DataSources
	SAP BW Hierarchy
	Transfer Methods for Writing Data to SAP BW
	IDoc Transfer Method
	PSA Transfer Method

	Creating an InfoSource or DataSource
	Creating a 7.x InfoSource in SAP BW 7.3
	Creating an InfoSource
	Creating a 3.x InfoSource
	Creating an InfoSource in SAP BW 3.5 or Earlier
	Creating a 7.x DataSource in SAP BW 7.3
	Configuring Hierarchy Structure

	Assigning an External Logical System
	Activating the InfoSource or DataSource

	Chapter 13: Building Informatica Objects for BW Data Load
	Informatica Objects for BW Data Load Overview
	Importing an SAP BW Load Data Object
	SAP BW Load Data Object Properties
	Creating an SAP BW Load Data Object Write Operation
	SAP BW Load Data Object Write Operation Properties
	Input Properties of an SAP BW Load Data Object Write Operation
	Ports Properties
	Run-Time Properties
	Advanced Properties

	Parameterization
	Partitioning
	SAP BW Load Mapping, Workflow, and Application Configuration

	Chapter 14: Loading Data to SAP BW
	SAP BW Data Load Overview
	Configuring an InfoPackage
	Creating and Scheduling an InfoPackage

	Configuring a Data Transfer Process
	Configuring a Process Chain to Load Data
	Creating the Process Chain and Inserting the Start Process
	Inserting an InfoPackage Process
	Inserting the ZPMSENDSTATUS ABAP Program

	BW Data Load Status
	Viewing SAP BW Service Log Events in the SAP BW Monitor
	Viewing InfoPackage Status



	Part V: SAP Pushdown Optimization
	Chapter 15: SAP Pushdown Optimization
	SAP Pushdown Optimization Overview
	Pushdown Optimization Expressions
	Pushdown Optimization Functions
	Pushdown Optimization Operators

	SAP Data Type Exceptions


	Appendix A: Data Type Reference
	SAP Data Types
	PowerExchange for SAP NetWeaver and SAP Data Types
	Unsupported SAP Data Types

	Index

